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Preface
Microsoft Excel is the world's leading spreadsheet program; it's
essential software for anyone working with tables of data and
needing to produce graphs and charts. This book is intended to
help newcomers to spreadsheets to learn the basic skills, using
simple, clear, everyday examples. A step-by-step approach is
used, developed over the author's many years of teaching.

Early chapters in the book show what you can do with Excel and
introduce the latest version, Excel 2007, with its Tabbed Ribbon
and radical new way of working compared with earlier software.

The book then gets down to the basic tasks of entering data,
performing calculations, saving spreadsheet files and printing on
paper. Jargon is avoided wherever possible but where necessary
it's explained in the text and in the Glossary at the end of the
book. The ease with which spreadsheets can be edited by
amending data and inserting and deleting rows and columns is
then discussed, together with formatting in different styles and
colours to make spreadsheets more attractive and readable.

Excel 2007 makes the drawing of eye-catching pie charts and
column and line graphs a simple task anyone can quickly master.
Professional -looking charts can greatly enhance a report or
presentation and creating these is explained in detail. The use of
Excel 2007 for creating a name and address database which can
be sorted and filtered is also discussed.

Later chapters explain basic file management tasks, such as
organizing, copying, moving and deleting files. Spreadsheets
saved as files on disc may contain important financial or personal
data and it's essential that these files are managed efficiently and
securely. Looking after your computer and its data files using
effective but inexpensive procedures is discussed in detail.

Although Excel 2007 was used in the preparation of this book,
users of earlier versions of Excel and other spreadsheet software
should also find much of the material helpful.
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Keyboard Shortcuts
Microsoft Office programs such as Excel provide a set of
keyboard shortcuts, used as an alternative to the mouse
and menus to carry out common tasks. Keyboard shortcuts
for some of the most commonly used Excel operations are
listed below. CTRL+B, for example, means "while holding
down the CTRL key press the B key".)

CTRL+A
CTRL+B
CTRL+C

CTRL+G
CTRL+I
CTRL+N
CTRL+O
CTRL+P
CTRL+S

CTRL+U
CTRL+V

CTRL+X

CTRL+Z

CTRL+END
CTRL+HOME
ARROW KEYS

DELETE
TAB
SHIFT+TAB
PAGE UP
PAGE DOWN
Fl

ENTER

Select the entire worksheet
Apply or remove bold formatting.
Copy selected cells to the clipboard, a
temporary store in the memory.
Displays the Go To dialogue box.
Applies or removes italics.
Creates a new, blank workbook.
Displays the Open dialogue box.
Displays the Print dialogue box.
Saves the current file with the current
name, location and file type.
Applies or removes underlining.
"Pastes" the contents of the clipboard
at the current insertion point.
Cuts the selected cells and places them
on the clipboard.
Uses the Undo command to reverse
the last command or cell entry.
Moves to the last cell in a worksheet.
Moves to the first cell in a worksheet.
Move around a worksheet one cell at a
time, up, down, left or right.
Removes the contents of selected cells.
Moves one cell to the right.
Moves one cell to the left.
Move one screen up in a worksheet.
Move one screen down in a worksheet.
Displays Microsoft Office Excel Help.
Completes an entry in a cel or the
Formula Bar and moves down one cell.



Introducing Spreadsheets
What is a Spreadsheet?
A spreadsheet is a table or grid consisting of a number of
horizontal rows and vertical columns, as shown below. Microsoft
Office Excel 2007 is the world's leading software for creating and
editing spreadsheets. This chapter gives an overview of the sort
of tasks which Excel 2007 can be used for; later chapters give
step-by-step instructions on the creation of Excel spreadsheets
and also charts and graphs, followed by practice exercises.

G12 =AVERAGE(1312:E12)

EA B C 0

1

2 Weekly Spending

3

4 Weeki Week2 Week3 Week4 Total Average

6 Food £49.57 £41.21 £51.89 £49.99 £192.66 £48.17

7 Heating £23.42 £25.48 £24.44 £28.89 £102.23 £25.56

8 Electricity £11.33 £8.88 £9.95 £12.11 £42.27 £10.57

9 Rent £97.00 £97.00 £97.00 £97.00 £388.00 £97.00

10 Petrol £18.49 £17.12 £21.21 £19.82 £76.64 £19.16

11 Car £28.00 £33.98 £49.99 £32.05 £144.02 £36.01

12 1Total £227.81 £223.67 £254.48 £239.86 £445.821 £236.461

The small boxes at the junction of each row and column are
known as cells. A cell can contain text, a number or a formula to
do a calculation.

Excel spreadsheets can be enormous - up to 16,384 columns
and over a million rows - more than enough for managing most
homes and small businesses! Cells are identified by a unique
"grid reference" based on the column and row headings; in the
above example, 236.46 in cell G12 has been calculated by
averaging the weekly totals in cells B12 to F12.



1 Introducing Spreadsheets

Advantages of Spreadsheets
The difference between a spreadsheet and an ordinary table
typed in a word processor is that the figures in the spreadsheet
can be used for calculations and to create graphs and charts.

Spreadsheets on paper were around long before computers were
invented and could involve many hours of laborious manual
calculations; typical tasks would include adding up rows and
columns of figures or multiplying two columns together.

Spreadsheets are ideally suited to exploit the power of a
computer to do routine calculations, reducing hours of work to a
matter of seconds. Not surprisingly spreadsheet programs were
amongst the first applications of computers along with word
processing and payroll calculations.

Excel 2007 is very easy to use

Although extremely powerful, Excel is very easy to use; even if
you don't like Maths you can still make good use of the program.

This is because quite complex tasks are
reduced to clicking with the mouse on an
icon (small picture) or on a menu option,

E AutoSum.q

E hum

&weft* as shown on the left.
assumes the range of

numbers you want to base the calculation on
and highlights them with a dotted rectangle,
as shown on the right. If necessary you can
adjust the dotted rectangle by dragging with
the mouse.

Recalculation - What if?

The program

36.251

45.15i
17.10:
9.35'

=SUM iE6:E9

Spreadsheet programs are widely used in business in a variety of
applications. For example, in house building you could enter the
costs of the materials and labour and calculate the total cost of
the house. Then predict how possible alternatives would affect
the total cost, such as "What if we used hardwood windows?

2



Introducing Spreadsheets 1

To find the effect of such changes on the price of the house,
simply enter the new costs into the spreadsheet. The
spreadsheet program automatically recalculates the new total
cost of the house. This recalculation feature is one of the main
advantages of spreadsheet programs and can save many hours
of work compared with traditional methods of calculation.

Graphs and Charts

Microsoft Office Excel 2007 is also used for presenting data
graphically in the form of pie charts and bar charts, etc.

Graphs and charts enable you to compare a set of figures "at a
glance". Working out the horizontal and vertical scales for a bar
chart or the angles for the slices of a pie chart, is a very laborious
task when done manually with pencil and paper, etc. Excel 2007
reduces the task to a few clicks with the mouse taking a matter of
seconds. Charts and graphs are discussed in more detail in later
chapters of this book.

3



1 Introducing Spreadsheets

Spreadsheet Applications
The next few pages give some examples of how spreadsheets
can be used. In practice a spreadsheet table or worksheet might
contain thousands of cells and hundreds of rows and columns.
However, these small examples should give an idea of the
diverse range of tasks possible with Excel 2007.

Sales of Bar Meals - Totalling Rows and Columns

The spreadsheet below involves two of the most common
operations; totalling along rows and down columns. There's no
need to do any mental arithmetic yourself - totalling a row or
column involves only two or three clicks with a mouse. As
discussed later, repeating a calculation down a column or along
a row is done automatically using the replication facility.

1 1

A

I. .SUM(811:F11)

Bar Meals

4 Meal Tues Wed Thurs frl Sat Total

o Pizza 3 a 9 12 17 49

7 Cod and chips 7 6 14 23 21 71

s Scampi 2 o II 13 18 47
i Mushroom Risotto 3 6 5 II I) 34

it) Coq au VIII 6 a 4 7 9 28

it Total 15 34 40 63 77 I 229

Cell Gil above contains the Total produced by adding all the
daily totals along row 11, as shown in the Formula Bar below.

Gil

It's then quite easy to produce a bar chart or pie chart, etc., to
show, for example, the most popular bar meals, as shown on the
next page.
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Sales of Bar Meals

Pizza Cod and Scampi Mushroom Coq au Vin
Chip; Risotto

Excel 2007 does all the work for you and enables you to create a
wide range of chart types in a matter of seconds.

Drink Sales - Multiplying Two Columns Together
In the example below, the sales in £ for each type of drink is
found by multiplying the price of one drink in column C by the
Number Sold in Column D.

E6 l C 6 11.._1)6

1

A L 8 C 0 L F

Drink Sales2

3

4 Description Price Number Sold Sales

5

N Tea 1.25 29 36.25

Coffee 1.29 35 45.15

8 Orange 0.90 19 17.10

9 Lemonade 0.85 11 9.35

10 Total 94 107.85

11

5



1 Introducing Spreadsheets

You can see from the Drink Sales spreadsheet that the Sales
figure for Tea, for example, in cell E6 is £36.25, obtained by
multiplying cell C6 by D6. This is shown as C6*D6 in the Formula
Bar across the top of the Drink Sales worksheet.

Eti 6111)6

Calculation of Body Mass Index (BMI)

BMI is a measure of a person's weight in relation to their height.
It is calculated using the following formula:

BMI = Weight in Kilograms
(Height in Metres) x (Height in Metres)

A spreadsheet can be used to monitor the BMI of a group of
people. for example to measure the success or otherwise of a
fitness program.

J. =E9/D9

A a F

Height Height xHeight Weight BMi

metres kilograms
4

5 Mike 1.83 3.35 108.41 32.37

6 James 1.75 3.06 88.00 28.73

7 Sue 1.57 2.46 52.16 21.16

S Jill 1.63 2.66 60.33 2231
9 Sarah 1.65 2.72 64.41 23.66

In the above example, the numbers in column C are squared i.e.
multiplied by themselves, to give the numbers in column D. Then
the Weight in kilograms in column E is divided by column D to
give the BMI in column F.

For example, the BMI for Sarah in cell F9 has been calculated
using the formula =E9/D9, as shown in the Formula Bar below.

=E9/D9
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Managing Lists of Narres and Addresses

In this example no calculations are involved; Excel 2007 is being
used here as a sort of database to store data.

75112118111.111=1=1:3
Home Insert Page t aye ut Formulas Data Renfrew View

--. 1 6 Anal - lu A. A.
--- , .=. . w :i General ri, Coaddronal f or

---' "A W= a -J1 - al - % , g Format as Table
Paste , B / 11 A - A -

.1 17 t..m V,- N8 :18 !ye Cel Styles 

Clipboard Font Alignment Number Styles

CIO I. Salmon Leap

A B C Ci E

1

2 High Peak Ramblers
3

4 First Name Surname Address Line 1 Address L ine 2 Address L Me 1
S Jill Austin Hinckley Farm Rad :iourne Derby

6 Jean Baker West mead Weever View L lc Nee Id

7 Mike Brunt 83 Valley Rd Thetford Norfolk

8 Robert Burns 14 Belmont Rd Murraybeld Edinburgh
9 Samuel Johnson Tie Cottage Great Cubley Ashboume

10 Sarah Mitchell ',Salmon Leap INorham Northumberland
ii Susan Slater Hightield MiN4ch Stone

12 Bob Smith 71 Church St Greenwich London

13 John Walker 1'1 London Rd Lewos E Susse,

14

The spreadsheet is a very convenient and simple way to enter
and save very large quantities of data, such as the names and
addresses of custome's of a business or members of a club or
society. Once entered and saved, the records can be easily and
quickly sorted into a particular order, such as alphabetical order
of surname. You can also search for and filter out records which
meet certain specified criteria.

The use of Excel 2007 as a data source for a mail merge and to
print out address labels is described in detail later in this book.

7



1 Introducing Spreadsheets

Summary of Spreadsheet Advantages

Programs like Excel 2007 are very easy to use; difficult
and laborious operations are reduced to simply clicking
icons and menu options.

Excel 2007 works in an intuitive way - often
anticipating correctly what you want to do.

Spreadsheet programs save an enormous amount of
time compared with manual calculations.

A spreadsheet can be instantly sorted into alphabetical
or numerical order; for example, a list of names and
addresses could be sorted into surname order.

Numerous copies can be printed out on paper quickly
and easily for distribution to colleagues, etc

Large sheets can be presented in various stylish ready-
made formats which are easy to read.

A spreadsheet can be saved as a file on a hard disc
and distributed as an e-mail attachment or on a CD.

A spreadsheet can be edited easily and updated with
the latest data from time to time. Cells produced as a
result of a calculation are automatically recalculated.

Tables of figures can be converted to attractive graphs
and charts very quickly and easily, saving a great deal
of time compared with traditional methods.

An Excel spreadsheet can be imported into a Word
document; for example when writing a report on sales
in a business or writing up the results of an experiment.

An Excel spreadsheet can be used to store a file of
names and addresses. This can then, for example, act
as the data source to print standard letters and address
labels using a mail merge.
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Excel 2007 and Microsoft Office 2007
Excel 2007 is a spreadsheet program, part of the Microsoft
Office 2007 suite of software. An inexpensive way to obtain
Excel 2007 is to buy the Office Home and Student 2007 edition
costing under £60: this software (Excel. Word and also
Publisher) has been Jsed in the production of this book. Many
small businesses. students and individual users will find that the
Home and Student edition of Office 2007 will meet all their
requirements. All versions of Office 2007 also contain the widely
used Word 2007 word processor, as shown in the table below.

L U.

Microsoft
Office
Basic
2007

Microsoft
Office

Home &
Student

20071

Microsoft Microsoft
Office Office

Standard Small
2007 Rumness

2007

Microsoft
Office

Profesuonal
2007

Microsoft
Office

Ultimate
2007

Mistosoll Office
Weill /007

MK mush Office
71 viol 1007

Miciosolt Office
IlithissiPoint 1007

Miciosoll Offits
Outlook /001

MICIP10f1 (AK 
Outlook /001 with
iosiosis t.onfact
Manage,

Microsoft Offs
Publisher /007

NIeleVAI Unite
AC(144 /007

In order to use Office 2007 and Excel 2007 you need a computer
equipped with either Windows XP or Windows Vista. Excel 2007
introduces a new "user interface" in the form of a tabbed Ribbon,
discussed shortly, but apart from that much of the material in this
book also applies to spreadsheets in general, including earlier
versions of Excel.
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Installing Excel 2007
As mentioned earlier, one of the most popular ways to get Excel
2007 up and running on your computer is to install the Office
Home and Student 2007 edition. The package consists of a
plastic box containing the software on a single CD. There should
be a label on the top of the box indicating that the copy of the
software is genuine. There is also a list of minimum hardware
and software requirements needed to run the software, namely:

500MHz or faster processor

256MB RAM

1.5MB available hard disc space

CD-ROM or DVD drive

1028x768 or higher resolution monitor

Windows Vista or XP with Service Pack 2

If your computer was bought within the last few years it should
comfortably meet these requirements.

Multiple Installations from a Single Office CD

Recognising that many homes now have more than one
computer, one Office Home and Student 2007 CD may be legally
installed on up to 3 computers.

The Product Key

On the back of an inner plastic case in the Office package is the
PRODUCT KEY label. This is your licence to install the software
- without it you can't validate and activate the software. It's worth
making a copy of the 25 -character key and storing it in a safe
place. You might have a technical problem later and need the
key to re -install the Office software.

At the bottom of a legally -obtained CD is a hologram in which the
word GENUINE alternates with the word MICROSOFT. Users of
illegal copies of software may find they can't install the latest
software upgrades or get telephone support.

10



Introducing Excel 2007 2

During the installation process you will be asked to enter your 25 -

character product key - letters must be in upper case. If you
don't enter a product key you will only be able to use the
software for a limited time, e.g. 30 days.

Microsoft Office Hem and 2007

I

Enter your Product Key

Type your 25 -character Product Key.

Although you are not reorect 33 enter your Product Key now, ne recommend you do so for ease of
..abiatno your Microsoft Office Ucense. For nforrnabon about nhere your Product Key es located, cid the
t-tett button.

If the product key is genuine, a green tick appears and you then
click Continue to carry on with the installation. After choosing to
either Upgrade or Customize you are presented with a window
showing the Progress of the installation as a percentage. Finally
you are informed that the software has been successfully
installed and you can, if you wish, click Go to Office Online to
get updates, help and online services.

As with many software installations, you need to restart the
computer before using the software for the first time.

Microsoft Office rare end Student 2007 has been successfully raided.

vet Microsoft Office Ohre to get free product updates, help, and wine len-cos.

aosoolkOriso-

Qose
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Activation

Microsoft Office has to be activated, a process intended to
prevent single -user editions of software being installed on more
than one computer. (Office Home & Student 2007 is an
exception, being licensed for up to 3 installations). During the
installation process you are given the choice to activate over the
Internet or by telephone. If you don't activate your copy of Office
you will only be able to use the software for a limited time.

Launching Excel 2007 from the All Programs Menu

At the end of the installation process you will find entries for
Microsoft Office, including Excel 2007, in the All Programs
menu accessed via the Start orb in the bottom left-hand corner
of the screen, as shown below.

Microsoft Office

fi

Microsoft Office Excel 2007

Microsoft Office OneNcte 2007

Microsoft Office Poo,erPoint 2007

Microsoft Office Publisher 2007

Microsoft Office 'Nord 2007

Microsoft Office Tools

I Back

Excel 2007 can now be launched by clicking its entry in the All
Programs menu shown above. As shown on later pages, a new,
radically different, "user interface" has been introduced in

Microsoft Office 2007. This has been applied to the Excel, Word
and PowerPoint 2007 programs; having so many features in
common makes the programs easier to learn and use.

12
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Launching Excel 2007 from the Start Menu

After you have used Excel 2007 for the first time, you don't need
to go onto the All Programs menu shown on the previous page.
Using Excel 2007 the tirst time places an entry for the program
directly on the Start menu as shown below.

Paint

X: Microsoft Office Excel 2007411.

.4k Backup and Restore Center

Microsoft Office Publisher 2007

Games

Recent Items

Computer

Network

A single click on the Excel 2007 entry above launches the
program.

Launching Excel 2007 from an Icon on the Desktop

Right -click over the entry for Microsoft Office Excel 2007 in the
All Programs or Start menus shown previously. Then click
Send To from the menu which appears and select Desktop
(create shortcut) as shown below.

Send To

Copy

Remove from this list

Compressed (zipped) Folder

NI Desktop (create shortcut)

Documents

Mail Recipient

An icon for Excel 2007 will now be part of your
Windows Desktop, as shown on the right. Double
click this icon every time you want to launch Excel
2007 and start a new spreadsheet session.

13



2 Introducing Excel 2007

The Excel 2007 Screen
When you launch Excel 2007 using one of the methods just
described you will see a blank worksheet ready for you to start
entering headings, data and formulae, discussed in detail shortly.

A a" 11- re aaai
112 IP

.11 bit 4i Cy.

I11,
rw

tr.

1r

MM.

The Excel 2007 Ribbon

Along the top of the screen is the tabbed Ribbon, a new feature
introduced in Office 2007. A section of the tabbed Ribbon is
shown below, with tabs such as Home, Insert and Page Layout.

Home

IT -111-1
Calibri

Paste
- J

Clipboard

Insert Page Layout Formulas Data Review

11 -f11 A'

B I u -

Al
in A

 
* it it; -

Alignment

When you select a different tab, such as Page Layout above,
the Ribbon changes to display a different set of icons or tools.
The tools displayed on the Ribbon may also change
automatically when you select a different task, such as a chart.

14



Introducing Excel 2007 2

The Office Button

A worksheet is createt, saved, edited,
printed and formatted using various tabs
and icons on the Excel Ribbon, such as
Home, Insert. Page Layout, etc.,
shown on the previous screen extract.
The Office Button on the left of the
Ribbon opens the menu shown on the
right, with options to Save and Print a
worksheet.

If you are connected to the Internet. click
the Office Button to display the menu
shown on the right anc then press the
Fl key located near the top left of your
keyboard. The Microsoft Office Online
Help appears, open at the Excel
section, as shown in the extract below.
There is also a Search facility to find help on particular topics.

GI=
Hew

ti
Qpen

Wlave

Save gs

Print

W Excel Help

* x ;; Ai 44., 4t
111111MINI.-

- P Search -

Excel

Suggestions

Use the Ribbon
ne..

What and where is the Microsoft Office Button'
earn- .e.;) .. ....spoe-e: to.

Browse t xcel Help

What's new

Inataing

Custonaang

Fie conversion and oxrpalliity

Getting help

Activating Excel

Accessbalty

Saving and pmbig

15



2 Introducing Excel 2007

The Home Tab

Each tab on the Ribbon is divided into a number of groups, so
that for example, the Home tab has groups such as Clipboard.
Font and Alignment shown below. These include many tools for
formatting the text and data in the cells, similar to those found in
a word processor.

Home Insert Page Layout Formulas Data Review

Paste

Clipboard '

Calibri - 11 - -
B I - a - ig -

F out

CIO

_1
-LA

Paste
1

Clipboard

formatting of
another; this includes the text size, bold, italics, font
colour, or numbers in currency format, for example.

Further along the Home tab on the Ribbon there are groups
called Number, Styles, Cells and Editing. These provide tools
for formatting numbers and text in cells and inserting and
deleting cells and entire rows and columns.

On the left of the Home tab on the Ribbon is the
Clipboard group, shown on the left, with icons to
Cut, Copy and Paste data between worksheets
or into a word processor document, for example.

The Format Painter on the right
provides a quick way of copying the
one piece of text or numbers to

View

General

- Vc,

(- -* Insert - E 
.,, .4;',4 -,/,

-4* Delete - l
Conditional Format Cell
Formatting - as Table - Styles - ;_l Format - -1-

I Number Styles Cells

16



Introducing Excel 2007 2

The Insert Tab

The Insert tab on the Ribbon, shown below, allows various fea-
tures to be inserted into a worksheet. These include many differ-
ent types of graphs and charts, such as Column, Line, Pie and
Bar Charts as shown on the Charts group on the Insert tab
shown below.

gr Fool 1

Home Insert Page Layout Formulas Data Review View

. I
2,)!k  ill EN

Ole Table Picture Clip Shapes SmartArt Column tine Pie Bar Area

ables Illustrations Charts

The Formulas Tab

The Formulas tab shown in the screen extract below contains
tools to perform a very wide range of mathematical calculations;
most users will, however, find their work is mainly confined to
common operations such as addition, subtraction, multiplication,
division and averages.

11 ,e) . Rood - lefeansaft he rl
4

fx
Insert

Function

Home Insert

E AutoSum-'

Page Layout Formulas Data Review .few

- Lookup & Reference - Define

Library

& Time - More Functions 

10 Math & Trig -

Manager II Create
Name

Defined N.

E Sum

gverage

Lount Numbers

Alin

A

The many icons representing tools on the various tabs on the
Ribbon provide a quick and easy way to create, format and edit a
spreadsheet.

The Excel Ribbon and tabs are discussed further in the context
of the worked examples which follow in the rest of this book.
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2 Introducing Excel 2007

Worksheets and Workbooks
In Excel 2007 a spreadsheet is also referred to as a worksheet.
Several related worksheets can be saved as a single file known
as a workbook. You can move between different worksheets by
clicking the tabs, Sheet1, Sheet2, Sheet3, etc., at the bottom of
the screen.

44 4 Sheet' Sheet2 Sheet3 Sheet4 Sheet5

When you save your work, all of the worksheets are saved in one
workbook, as a single file on your hard disc. If you don't give the

new workbook a name it's saved by default as
- - -- Book1 or Book2, etc. The icon on the left and on
the right above allows you to insert an extra worksheet in the
workbook.

Changing the View on a Worksheet

At the bottom of the Excel 2007 screen there is a scroll bar
allowing you to pan across a worksheet. There is also a slider
allowing you to alter the Zoom to enlarge or reduce the view.

11

In the extract below the Zoom slider has been set at nearly
300%

AAA

A'

. u .-A-

A

man air Ai

B

"^ 111
% Id

1.1.1111.,

C

,

Cells

1/ }1
<

D E

2 Weekly Spending

3 Week1 Week2 Week3 Week4

4 Food 49.57 41.21 51.89 49.99.
5 Heating 23.42 25.48 24.44 28.89

6 Electricity 11.33 8.88 9.95 12.11

7 Rent 97.00 97.00 97.00 97.00 I
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3
Entering Labels,
Numbers and Formulas

Moving Around in a Worksheet
After you launch Excel 2007 from the Start menu or by double-
clicking a desktop icon, as described in the previous chapter,
you are presented with a new sheet consisting of a blank grid of
cells. Click anywhere on the worksheet, such as cell D3 shown
below, and you are reacy to start entering data.

A

1

2

3

D3 Ix

As this is a new workbook, Bookl is displayed at the top of the
screen until you save the spreadsheet
with a suitable name, which you make
up. There are tabs for Sheetl,
Sheet2, Sheet3, etc., along the bottom of the worksheet, as
shown below.

Bookl MK-tom:1ft Excel

14 4 0 01 Meal Sheet2 Sheet3 Sheet4 Sheets 7

Moving Down a Column

Now try pressing the Return or Enter key repeatedly; the cursor
moves down the current column from cell to cell. You'll soon find
the row numbers going into the hundreds, as in cell D244 below.

D244 fir

A
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3 Entering Labels, Numbers and Formulas

Moving Along a Row

From the current cell, press the Tab key shown on the
right. This moves the cursor along a row from left to
right.

Holding down the Shift key while pressing the Tab key
moves the cursor along a row from right to left.

Ir

Tab

Lo')
Alternatively the four arrow or cursor Shift
keys, shown on the left, allow the
cursor to be moved around the worksheet in any
direction.

On large worksheets the horizontal and vertical scroll bars can
be used to move to a certain part of the sheet.

The Page Up and Page Down keys move up and down the
spreadsheet in steps of 25 rows at a time.

To move quickly to the beginning or end of a spreadsheet, use
the key combinations Ctrl+Home or Ctrl+End respectively.
(While holding down the Ctrl key, press the Home or End key).

Moving to a Specified Cell

Click in the Formula Bar at the top of the worksheet, delete the
current cell reference and enter the one you wish to move to, e.g.
D273. When you press Enter the cursor is placed in the required
cell.

D273

A

269

270

271

272

1731

1.

D
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Entering Labels, Numbers and Formulas 3

Cell Contents
In the Drink Sales spreadsheet below, the currently selected cell
D10 is shown in the Formula Bar across the top of the
worksheet. Also displayed are the cell contents, in this case the
formula =D6+D7+D8+D9.

D10 .fx =06+07+08+09

E

1

A 0

2 Drink Sales
3

4 Description Price Number Sold Sales

S £ £

6 Tea 1.25 29 36.25

7 Coffee 1.29 35 45.15
8 Orange 0.90 19 17.1

9 Lemonade 0.85 11 9.35

10 Total 94 107.85

Entering Labels into a Cell

In the above small spreadsheet or worksheet, you can see that
some cells contain words or labels, such as the worksheet title
Drink Sales and the column and row headings, e.g.
Description, Price, etc. To enter a label, simply click in the
required cell and start typing. When you've finished typing, press
Enter or use one of the other methods described earlier to move
to the next cell. Labels can be edited at any time, after double-
clicking in the appropriate cell.

Widening a Column to Accommodate Labels or Data, etc.

If a column is not wide enough for a label, data, or formula, place
the cursor on the vertical line to the right of the letter at the top of
the column. A small cross appears. This is used for adjusting the
width of a column, as shown on the next page.
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3 Entering Labels, Numbers and Formulas

In the example below, to widen Column D, drag the cross shown
on the right of the header for Column D. Column D can also be
widened by dragging the cross which appears between Columns
C and D, although this reduces the width of Column C.

C13

A Ji B C n

2 Drink Sales
3

4 Description Price Number Sold Sales

Entering Numbers into a Cell

Click in the cell and type the numbers straight in. You can format
the numbers later, e.g. to display every number with two decimal
places or in integer format (no figures after the decimal point).
Formatting numbers including the £ sign in the Currency format
is discussed in more detail later in this book.

Entering a Formula into a Cell

First select the cell where the answer is to appear. Then the
formula is either typed into this cell or entered by selecting a
function, such as Average, for example, from the Formulas tab
on the Excel 2007 Ribbon.

=D6+D7+D8+D9 Add together the contents of cells D6 to D9.

=D10 -D8 Subtract the contents of cell D8 from D10.

=C6*D6 Multiply contents of cell C6 by contents of D6.

=E10/D10 Divide contents of cell E10 by 010.

Please note:

* is used as the spreadsheet multiplication sign.

/ is the sign for division.
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Entering Labels, Numbers and Formulas 3

While you are typing a formula, it is displayed both in the cell and
in the Formula Bar near the top of the spreadsheet

.!e 4)6+07+08+09

When the formula has been correctly entered, click the tick in the
Formula Bar shown above, or press Enter. Once the calculation
is complete a calculated cell, such as D10 in the worksheet
below, does not normally display the formula, in this case
=D6+D7+D8+D9.

D10 4,16+07+08+09

1

2

3

A

Drink Sales

4 Descript ion Price Number Sold Sales

S £ £

6 Tea 1.25 29 36.25

7 Coffee 1.29 35 45.15

8 Orange 0.90 19 17.1

9 Lemonade 0.85 11 9.35

10 Total 94 107.85

Only the answer to the sum appears in the cell D10 above, even
though the formula was originally entered in this calculated cell.

Displaying the Formula in a Calculated Cell

To display a formula in a particular calculated cell, double-click in
the cell, as shown below for cell D10 of the Drink Sales
worksheet. The formula =D6+D7+D8+D9 then appears, as
shown below, instead of the answer 94 as shown above.

Lemonade 0.85 11 9.35

Total 4)6+D7+08+09 107.85
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3 Entering Labels, Numbers and Formulas

Totalling Rows and Columns - the SUM Function

In the previous example, a column containing 4 numbers was
totalled using the formula =D6+D7+D8+D9. In a business
spreadsheet it may be necessary to total hundreds of numbers
down a column or along a row. For this task, Excel 2007 provides
the SUM function which can be manually typed e.g.

=SUM(D6:D9)

In this example, (D6:D9) refers to the range of cells from D6 to
D9 inclusive. To save typing in by hand this frequently -used
function, Excel 2007 provides the AutoSum icon on the

Formulas tab on the Ribbon, shown below.

fx

Home Insert Page layout Formulas Data I

1 Z AutoSum .1  Logical - ct, Lookup & Reference -

r Recently Used - a Text - Le Math & Mg -

If you select a cell then click the
AutoSum icon, Excel assumes you
want to add up the numbers above or to
the left of the currently selected cell. The
assumed range is shown dotted in the
example on the right. It's a good idea to
check that the range of cells which Excel
has assumed is correct. If necessary,
manually alter the range by editing in the
cell or in the Formula Bar as shown
below.

a-

Number Sold

-9

SUM v claidigiL=SUM(Do:D9)

A C D

When you are satisfied the formula is correct either press Enter
or click the tick in the Formula Bar as shown above, to complete
the calculation. To redo the calculation from scratch, click the
cross in the Formula Bar.
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Entering Labels, Numbers and Formulas 3

Multiplying Two Cells Together
In the Drink Sales spreadsheet shown on page 23, the value of
the Sales of each drink in Column E is calculated by multiplying
the Price in Column C by the Number sold in Column D.

This is achieved for Tea, for example, by entering the formula
=C6*D6 in cell E6, as shown below.

k .CtiD6

A

2 Drink Sales

4 Description Pnce Number Sold

5

Tea i 1.25 I
Sales

When you press Enter or click the tick in the Formula Bar shown
above, the answer 36.25 appears in cell E6, shown below.

4

S

6

Description Price Number Sold Sales

Tea 1.25 29 I 16.25

Now the formulas for the Sales in £ for Coffee, Orange and
Lemonade must be catulated and the answers placed in cells
E7 to E9. This could be done by typing the formula into each cell
in Column E, as shown below under Sales.

4 DeSCfpilan Price Number Sold Sales

!,

o Tea

E

1.25 29

E

-C6116

7 Coffee 1.29 35 --C 7D7

i Orange 0.9 19 =CPU
9 Lemonade 0.05 11 =C9139

This would take too long on a large spreadsheet and the
replication feature is provided to enable a formula to be copied
easily and quickly by dragging with the mouse, as discussed in
the next chapter. Cell references are adjusted automatically.
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3 Entering Labels, Numbers and Formulas

Editing a Cell at a Later Date

You can edit a cell containing a label, number or formula at any
time in the future. The cell contents can be edited either in the
cell or in the Formula Bar (sometimes also called the Entry Bar).

To edit the cell contents by typing in the cell, double-click
in the cell and start editing.

To edit the cell contents by typing in the Formula Bar, click
once in the required cell then click in the Formula Bar and
start editing.

Functions

For more complex calculations, a complete set of
mathematical functions is available by clicking Insert
Function on the Formulas group on the Excel 2007
Ribbon, as shown below.

Insert
Function

Insert Function

Search for a furxbon:

Type a bnef de-scnpOon of A at you ~writ to do and then dad(
Go

Or select a category: Most Recently Used

Select a funcbon:

SUM

D

±r

ERAGE

AVERAGE(sonherkombeele.)

You can also search for a suitable function by entering a
description of what you want to do. Many users will probably find
the basic mathematical operations of addition, subtraction,
multiplication, division and averages are more than adequate in
most applications of spreadsheets.
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4
Creating, Saving and
Printing a Spreadsheet

This chapter takes you through the following spreadsheet skills:

Starting a new spreadsheet

Entering text and r umbers

Totalling rows and columns, including replication

Saving and printing the spreadsheet

Displaying and printing formulas

The next few pages describe the entry and calculation of the
Weekly Spending spreadsheet shown below. You may wish to
read first
at the end of this chapter.

610 - 1. =AVERAGE11110:E10)

A 8 0 E F 116.9

2 Weekly Spending
3 Weekl Week2 Week3 Week4 -otal Average
4 Food 49.57 41.21 51.89 49.99 192.66 48.17
S Heating 23.42 25.48 24.44 28.89 102.23 25.56
6 Electricity 11.33 8.88 9.95 12.11 42.27 10.57
7 Rent 97.00 97.00 97.00 97.00 388.00 97.00
8 Petrol 18.49 17.12 21.21 19.82 76.64 19.16
9 Car 28.00 33.98 49.99 32 C5 144.02 36.01

10 Total 227.81 223.67 254.48 239 86 945.8216 4. 16.

Excel 2007 must fist be launched from the Start or All
Programs menus or by clicking on the icon on the desktop as
discussed in Chapter 2. You are then presented with a blank
worksheet in which to start typing the labels, data and formulas.
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4 Creating, Saving and Printing a Spreadsheet

Entering the Labels and Headings

Referring to the spreadsheet on the previous page, first the title
Weekly Spending is entered. Then the column and row
headings or labels Weekl. Week2, etc., Food, Heating, etc.,
can be entered. (Widening a column to accommodate a wide
label is described on page 21).

B10

B

.1;

C D E

1

Weekly Spending

3 Weekl Week2 Week3 Week4

4 Food 49.57 41.21 51.89 49.99

S Heating 23.42 25.48 24.44 28.89

6 Electricity 11.33 8.88 9.95 12.11

7 Rent 97.00 97.00 97.00 97.00

8 Petrol 18.49 17.12 21.21 19.82

9 Car 28.001 33.98 49.99 32.05

10 (Total 11

Entering the Numbers

The numbers are typed straight into the cells. A convenient
method is to work down the columns, pressing Enter to move
down to the next cell. Formatting the numbers, for example in the
Currency format with a £ sign and two places after the decimal
point, is discussed in Chapter 5.

28



Creating, Saying and Printing a Spreadsheet 4

Calculated Cells - Totalling a Column

A formula must be ertered in cell B10 to calculate the Total
expenditure in Week1.

To do this, click in cell B10 then click the
AutoSum icon shown on the right. This is found
on the Excel 2007 Ribbon with the Formulas tab selected.

E AutoSum -

SUM

A B I C

1

2 Weekly Spending
3 Weekl Week2 Week3 Week4
4 Food 49.57 41.21 51.89 49.99

5 Heating /1 23.42 25.48 24.44 28.89

6 Electricity/ 11.33 8.88 9.95 12.11

7 Rent 97.00 97.00 97.00 97.00

8 Petrol / 18.49 17.12 21.21 19.82

9 Car 28.00 33.98 49.99 32.05

10 1Total B

If you a -e happy that the formula and the range of cells within the
dotted rectangle are correct, click the tick in the Formula Bar to
carry out the calculation.

SUM XVAI =SUM(84:89)
If the formula is not correct, click the cross and type the correct
formula in the Formula Bar or adjust the range of cells by
dragging the dotted rectangle, using the mouse. When the
calculation of the Total is complete,
the answer 227.81, not the formula,
is displayed in cell B10 as shown on
the right.

S Petrol

9 Car

.1.0 Total

18.49

28.00

I 227.81
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4 Creating, Saving and Printing a Spreadsheet

Replication

This is a great labour-saving feature of spreadsheets. Having
calculated the total for Week1, the same method can be applied
to Week2, Week3 and Week4 by a simple mouse operation.

The method of replication is as follows:

1. Select the cell containing the formula to be replicated, cell
B10 in this example.

2. Allow the cursor to hover over the bottom right-hand
corner of the cell until a small cross appears, as shown
below to the right of 227.81.

8 Petrol 18.49 17.12 21.21 19.82

9 Car 28.00 33.98 49.99 32.05

10 Total 227.81
11

3. Hold down the left mouse button and drag the cross over
the cells where the calculation is to be replicated. The
totals for Week2, Week3 and Week4 (223.67, 254.48 and
239.86) appear in the cells automatically as shown below.

8 Petrol 18.49 17.12 21.21 19.82

9 Car 28.00 33.98 49.99 32.05

10 Total 227.81 223.67 254.48 239.861

Displaying the Formulas in All Calculated Cells

Select the Formulas tab on the Excel 2007 Ribbon and then
click Show Formulas on the right of the
tab. All of the formulas replicated along row Show Formulasi

10 of the Weekly Spending spreadsheet
are then displayed, as shown below.

9 Car

10 Total
28.00 33.98 49.99 32.05

=SUM(134:139) =SUM(C4:C9) =SUM(D4:D9) =SUM(E4:E9)
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Creating, Saving and Printing a Spreadsheet 4

Totalling Along a Row

Returning to the Weekly Spending spreadsheet, we might wish
to calculate the amount spent on each item - Food. Heating.
Electricity, etc., over the 4 -week period. This involves totalling
along each horizontal row of the worksheet in turn.

First the label Total is entered in cell F3. Then the formula to
total along the Food row, =SUM(B4:E4) is entered in cell F4.
This can be entered either by typing the formula
into the cell or by clickirg the AutoSum icon on
Formulas tab on the Excel 2007 Ribbon.

E AutoSum

1--St14 v kiladAbLUM(B4:E4)
A

1

3 Weekl
Weekly Spending

Week2 Week3 Week4 Total
4 Food 49.57 41.21 51.89 49.990111
5 Heating 23.42 25.48 24.44 28.89

6 Electricity 11.33 8.88 9.95 12.11

7 Rent 97.00 97.00 97.00 97.00

8 Petrol 18.49 17.12 21.21 19.82

9 Car 28.00 33.98 49.99 32.05

10 Total 227.81 223.67 254.48 239.86

AutoSum has a guess at the range of cells you wait to total, as
shown above by the dotted rectangle. In some situations this
assumed range may not be what you intend, depending on the
particular context, so check the range carefully. Tien click the
tick in the Formula Bar cr press Enter if you are satisfied with the
formula. Otherwise click the cross and redo the calculation.

Y,XV.k: ./ivll134:4)
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4 Creating, Saving and Printing a Spreadsheet

Replicating a Formula Down a Column

We now need to repeat the row totalling for the other items of
expenditure, Heating. Electricity. Rent, etc. This means copying
the formula in cell F4, but making the necessary adjustments to
the cell references, i.e. =SUM(B5:E5), =SUM(B6:E6), etc.

First click in cell F4 and allow the cursor to
hover over the bottom right of the cell until a
small cross appears. Keeping the left mouse
button held down, drag the cross down the
column, over the cells into which the formula
is to be replicated.

After you release the mouse button the
answers to the row totals appear in the cells,
as shown below.

Week4 Total

49.991 192.

28.89

12.11

97.00

19.82

32.05

239.86

F10 fr I UM(810:E10)

A B C D E

1

2 Weekly Spending
3 Weekl Week2 Week3 Week4 Total
4 Food 49.57 41.21 51.89 49.99 192.66

5 Heating 23.42 25.48 24.44 28.89 102.2:1

6 Electricity 11.33 8.88 9.95 12.11 42.27

7 Rent 97.00 97.00 97.00 97.00 388.00

8 Petrol 18.49 17.12 21.21 19.82 76.64

9 Car 28.00 33.98 49.99 32.05 144.02

10 Total 227.81 223.67 254.48 239.86r 945.82

Click Show Formulas on
the Formulas tab on the
Ribbon to display the
formulas replicated from cell F4 to cells F5 to F10,
as shown in the extract on the right.

A Show Formulas
Total

=SUM( B4:E4)

...SuM(B5:E.5)

=SuM(B6:E6)

=SUM(B7:E7)

=SUM( 98:E8)

UM(B9:E9)
I=SUM(B10:E10)
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Creating, Saving and Printing a Spreadsheet 4

Using the Average Function

To find the average amount spent on
each item, (Food. Heating, etc.), first
place a label, Average. in cell G3. Then
place the cursor in cell G4 and click the
small downward pointirg arrow next to
AutoSum on the Excel 2007 Ribbon.
Now click Average shown above on the right and you are
presented with the average calculation shown below.

X AutoSum 1

X Sum

Average

Count Numbers

A

AVERAGE(B4:F4)164NE
0

2 Weekly Spending
3

[4
Vieek1 Week2 Weekl week4 Twat Average

Food r 49.57 41.21 51.29 49.99 192 661,AVERAGE(.111

S Heating 23.42 25.48 24.44 29.89 102.23

6 Electrictly 11.33 8.88 9.95 11.11 42.27

7 Rent 97.00 97.00 97.00 97.00 322.00

8 Petrol 18.49 17.12 21.21 19.82 76.64

9 Car 2240 33.98 49.99 32.05 144.01

10 Total 227.81 223.67 254.48 299.86 945.82

In this case the range of numbers, (B4:F4). assumed for the
average. is incorrect. This is because the Total of 192.66 in F4
has been wrongly included along with the weekly spending
figures in B4 to E4. We can correct this by clicking in the formula
bar shown below and editing the formula to show =Average
(B4:E4).

XV AI A V ER AGE(B4:E4)

When you are happy with the formula click
the tick and the first (correct) Average. 45.17.
should appear in cell G4. Now replicate the
formula down column G by dragging the
cross, as previously described, to complete
the Average column, as shown on the richt.

iCial Overage

192.66 48.17
172.23 25.56

42.27 10.57

338.60 97.00

76.64 19.16

144.62 36.01

945.82 235.46
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4 Creating, Saving and Printing a Spreadsheet

Saving a Spreadsheet
After you have created a spreadsheet it needs to be saved on
your hard disc. Then it can be retrieved at a later date and edited
or extended. With a large spreadsheet containing important data
it's essential to make a backup copy on a removable storage
medium such as a CD or a memory stick and this is discussed
later in Chapter 9, Safety Precautions.

To save a spreadsheet as a file on your hard
disc, click the Office Button on the Excel 2007
Ribbon to open the menu shown on the right.
Now click Save As from the menu to open the
Save As dialogue box shown below. (You don't
need to wait until the spreadsheet is complete
before saving it. You can save the initial blank

sheet using Save As and a made-up
name. Then in future regularly click the
disc icon on the Excel Ribbon to keep
saving the latest version of the sheet.)

Nev.

Qpen

irni

<, Excel spreadsheets

Documents

Recent Places

U Desktop

Computer

pictures

ip Music

More

Folder

Name

File Dame: Weekly spending

Save as type. Excel Workbook CA*

n.e T humbnAil

Hide Folders

Date meddled Type

This folder is empty.

S.:e

Tags: Add teg

Thais Sbffle I Car cd
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Creating, Saving and Printing a Spreadsheet 4

At the top of the Save As dialogue box shown on the previous
page, is the folder, called Excel spreadsheets in this example.
This is the location on your hard disc where the file will be saved.
You can change to another folder by browsing through the
Favorite Links such as Computer, shown on the left of the
Save As dialogue box on the previous page. Alternatively you
can click New Folder shown below and create and name your
own folder such as Excel spreadsheets.

At the bottom of the Save As dialogue box shown on the
previous page, you can enter a name for your spreadsheet.
Excel 2007 calls them Workbooks and Worksheets and by
default calls new workbooks Bookl, Book2, etc. Delete the
default file name Bookl.xlsx and type in a suitable name such
as Weekly spending as shown below.

File name Weekly spending

Save as type: Excel Workbook (*.xlsx)

Make sure the Save as type is set at Excel Workbook(*.xlsx)
as shown above and click the Save button at the bottom right of
the Save As dialogue box. The file name extension .xlsx is
added automatically.

Now you've given the spreadsheet a name and specified
a folder location, all subsequent saves can be done by

simply clicking the disc icon shown on
the rigtr. This is located above the Ribbon, next
to the Office Button, as shown on the left.
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4 Creating, Saving and Printing a Spreadsheet

Printing a Spreadsheet
You may want to print a "hard copy of a spreadsheet so that it
can be viewed away from the computer. Click the Office Button
and then select Print and you are presented with three options:

Li LOW

2Pel

SW.

rL Save ;?.s

Pant

I loin .

Preview and print the document

print
Select a printer, number of copies, and
other printing options before printing.

Qukk Print
Send the workbook directly to the default
printer without making changes.

Print Preview
Preview and make changes to pages before
printing.

Print and Quick Print make a copy on paper, but it may not be
in the best format. Print allows you to specify the number of
copies and also to print selected cells or an entire workbook
consisting of several worksheets (spreadsheets). Print Preview
allows you to see what the printed sheet will look like on the page
and make adjustments before committing it to paper.

Portrait or Landscape
A spreadsheet is often too wide to fit on a
single sheet of paper, such as A4. A wider
sheet can be printed by setting the sheet in
Landscape orientation, (paper sideways)
rather than Portrait (paper upright). This option
can be set by clicking Orientation on the Page
Layout tab of the Excel 2007 Ribbon.

Page layout Form

I

Orientation Si:e

Portrait

Landscape
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Creating, Saving and Printing a Spreadsheet 4

Printing Gridlines

The gridlines marking the rows and
columns can be printed on paper by
selecting the Page Layout tab on the
Excel 2007 Ribbon, then making sure
there is a tick next to Print under
Gridlines in the Sheet Options group
as shown on the right.

Displaying and Printirg Formulas

Gridlines Headings

 View  View
 Print Print

Sheet Options r.

To print a copy of a spreadsheet show ng
all of the formulas used, select the
Formulas tab on the Excel 2007 Ribbon,
then click Show Formulas. The calculated
the formulas, not the answers. However when the

Show Formulas

cells now display
formulas are

displayed the column widths are greatly increased. These can
be reduced substantially by dragging, as discussed in Chapter
3. It may also be advantageous to set the spreadsheet in
Landscape orientation as described on the previous page. An
extract from the Weekly Spending spreadsheet with the
formulas displayed is shown below. The spreadst-eet and the
formulas can now be pr nted on paper in the usual way.

821

Weekl
Weekly Spending

Week2 Week3 Week4

A

2

3

4 Food 49.57 41.21 51.89 49.99

5 Heating 23.42 25.48 24.44 28.89

0 Electricity 11.33 8.88 9.95 12.11

7 Rent 97 97 97 97

8 Petrol 18.49 17.12 21.21 19.82

9 Car 28 33.98 49.99 32.05

10 Total =SUM(:4:139) rSUM(C4:C.9) .SUM(104:D9) =SuM(E4:E9)
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Exercise 1: Creating a Spreadsheet and
Entering Data and Formulas

1. Launch Excel 2007.

2. Enter the title Weekly Spending.

3. On a row below the title, enter the column headings
Week1, Week2, Week3, Week4. You may wish to align
the column headings using one of the icons in the
Alignment group on the Home tab of the Ribbon. First
select the entire row by clicking in the box containing
the row number.

4. Enter in the first column the following row labels, which
can be left -aligned after clicking in the column header
box at the top of the spreadsheet:

Food. Heating, Electricity, Rent, Petrol. Car, Total

5. Enter the following numeric data:

Week1 Week2 Week3 Week4

Food 49.57 41.21 51.89 49.99

Heating 23.42 25.48 24.44 28.89

Electricity 11.33 8.88 9.95 12.11

Rent 97.00 97.00 97.00 97.00

Petrol 18.49 17.12 21.21 19.82

Car 28.00 33.98 49.99 32.05

6. Enter a formula to calculate the Total spending for
Week1.

7. Replicate this formula for the other weekly totals.

8. Save the spreadsheet with a name such as
Spending1.

9. Print a copy of the spreadsheet on paper.

10.Display all the formulas on the screen and print a
copy.
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5
Editing and Formatting

This chapter covers the following spreadsheet skills:

Altering the cell contents - numbers, labels or formulas

Deleting rows and columns

Inserting rows and columns

Formatting text - font style, size, cclour, alignment

Formatting numbers - whole numbers, decimal places,
currency format, etc.

Editing the Cell Contents
The method of editing a cell is basically the same whether the
cell contains text (labels headings, etc.), numbers or a formula.

The contents of a cell can be edited either by typing the
amendment in the cell itself or by typing in the Formula Bar
above the spreadsheet.

Editing in the Cell

To edit the cell contents in the cell,
double-click in the cell; the cursor
flashes in the cell allowing you to
type in the new contents. Press
Enter to complete the amendment.

Editing in the Formula Bar

Click once in the required cell then click again in the Formula
Bar. Now type the amerdment in the Formula Bar then click the
tick to complete the new entry.

Total Average

192.661=AVERAGE()

X =AVERAGE(B4:E4)

_LY
.3c)
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Deleting a Row
It may be necessary to delete a row from a spreadsheet; for
example, to remove the Petrol row from the Weekly Spending
spreadsheet shown below.

Select or highlight the row by clicking in the box on the extreme
left of the row, in this example the box containing the row number
8 next to the label Petrol, as shown below:

A8 w Petrol

I A
1

a
I

c o
1

2 Weekly Spending
3 Weeki Week2 Week3
4 Food
S Heating
6 Electricity
7 Rent
8 Iretrol
9 Car

49.57 41.21 51.89

23.42 25.48 24.44

11.33 8.88 9.95

97.00 97.00 97.00

18.49 17.12 21,21,

28.00 33.98 49.99

Now click the small arrow to the right of Delete in the Cells group
on the Home tab as shown below. Then select Delete Sheet
Rows. All of the cell contents are removed and the space
previously taken by the row is closed
up, i.e. no blank row is left.

You can also delete a row by
selecting the row then pressing the
Delete key. This removes the cell
contents but a blank row remains.

Inset X -r Witt E- 4
-41.walk. 41.1

Swett Cos-

# Wee Simi lows

Dusts Mitt
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Deleting a Column
Highlight the column by clicking in the column header, i.e. the
box containing the column reference -C in the example below.

A C D

1

2 Weekly Spend ing

3 Weekl Week? Week3

4 Food 49.5 41.21 51.89

S Heating 23.42 25.48 24.44

6 Electricity 11.33 8.88 9.95

7 Rent 97. 97.00 97.00

8 Petrol 18.49 17.12 21.21,

Now click the small arrow next to
Delete in the Cells group on the
Home tab. Then select Delete
Sheet Columns as shown on the
right. This removes the entire
column. The space previously
taken by the column is closed up
so that no blank column remains.

l'* Insert -

-444 Delete -1

E  A irzi
Ir.

444 Delete Cells...

9ir Delete Sheet Lekarnm

Delete sheet

You can also delete a column by selecting the column then
pressing the Delete key. This removes the cell contents but a
blank column remains.

Recovering from Mistakes - the Undo Feature
If you make a mistake with any operation such as deleting cells,
the situation can be recovered by clicking the Undo icon
shown on the right. This is found on the Quick Access
Toolbar above the Excel Ribbon, shown below.

41



5 Editing and Formatting

Inserting a New Row
Click anywhere in the row which is to be immediately below the
new row. In the above example, the cursor was placed in the row
for Electricity.

E6 11..-

Week3

A

3

Weekly Spending
Week! Week2

4 Food 49.57 41.21 51.89

5 Heating 23.42 25.48 24.44

6

7 Electricity 11.33 8.88 9.95

8 Rent 97.00 97.00 97.00

9 Petrol 18.49 17.12 21.21

10 Car 28.00 33.98 49.99

11 Total 227.81 223.67 254.48

Week4

49.99

28.89

I

12.11

97.00

19.82

32.05

239.86

Then click the arrow to the right of
Insert on the Cells group on the
Ribbon. Now click Insert Sheet
Rows as shown on the right. A
new, blank row is inserted ready
for you to start entering the data.

Notice that the formulas for the
totals are now in row 11 and not 10. Excel 2007 automatically
takes account of this and changes the formulas accordingly. For
example, the original Total in cell B10 above was =SUM(B4:139)
After inserting a new row, the Total, now in cell B11, becomes
=SUM(B4:B10). The other totals along row 11 are adjusted
automatically in a similar way as shown below.

- Insert Cells

.1,

Insert Sheet flows

Insert Sheet columns

!Wiest Sheet

10 Car 28 33.98 49.99

11 Total UM(134:810) =SUM(C4:C10) =SUM(D4:010)
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Inserting a New Column
Click anywhere in the column which is to be to the right of the
new column. In the example below, the cursor was placed in the
column for Week3, originally Column D.

A

1

2

3 Weekl
Weekly Sper

Week2

1

Week3 Week4

iing

4 Food 49.57 41.21 51.89 49.99

S Heating 23.42 25.48 24.44 28.89

6 Electricity 11.33 8.88 9.95 12.11

7 Rent 97.00 97.00 97.00 97.00

8 Petrol 18.49 17.12 21.21 19.82

9 Car 28.00 33.98 49.99 32.05

10 Total 227.81 223.67 254.48 239.86

Then click the arrow to the right of
Insert in the Cells group on the
Ribbon. Next select Insert Sheet
Columns as shown on the right. A
new blank column is inserted as
shown above, ready for the new
data to be entered.

Insert nil -

Insert Cills

J J
5 Insert Sheet Loh. mns

Inlett Sheet

Please Note:

Excel 2007 adjusts formulas in calculated cells automatically
when rows and columns are inserted or deleted. However,
it's a good idea to display each formula and quickly check
that cell ranges such as (B4:F4), for example, are correct.

As discussed earlier, 'ormulas are displayed in the Formula
Bar at the top of a worksheet or displayed in a calculated cell
by double-clicking in the cell. Alternatively click Show
Formulas on the Formulas tab on the Excel 2007 Ribbon.
Windows Vista users may need to close the Wirdows
Sidebar to display the Show Formulas icon in full.

-1:
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Exercise 2: Editing a Spreadsheet
This exercise covers the editing skills described in the
previous section. Please refer back to the notes if you
need help with any of the tasks.

1. Load up the spreadsheet saved in Exercise 1 on page
38, which you may have saved with the sucgested title
Spendingl.

2. Please make the following amendments: The cost of
Heating in Week1 should be 28.59. The amount spent
on Rent in Week4 should have been 109.00. (Omit the
£ sign at this stage - Currency format is discussed
shortly.)

3. Delete the row labelled Petrol.

4. Enter a label, Total, on the right of the label Week4.
Enter a formula to calculate the Total spent on Food
for all four weeks.

5. Replicate the formula used for calculating the Total
spent on Food, for each of the other items, Heating,
Electricity, Rent, Petrol and Car.

6. Save the spreadsheet with a name such as
Spending2.

7. Insert a new column after Week4 and before Total with
the heading Week5. Enter the following data in the
Week5 column: Food 53.97, Heating 31.29,
Electricity 13.14, Rent 109.00, Petrol 25.42, Car
45.11.

8. Calculate the Total spending in Week5.

9. Check that the figures for Week5 have been included in
the new figures in the Total column.

10.Save the spreadsheet with a name such as
Spending3.

11.Print a copy of the spreadsheet.
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Formatting a Spreadsheet
Excel has many formatting features to change the way text and
numbers are displayed in the cells. The main formatting effects
are accessed from the Excel 2007 Ribbon in the Font and
Alignment groups on the Home tab, as shown below.

Arial - 10 - A A
B I jj -

Font :..1ionment

Labels and numbers can be aligned in the cells in
several ways - left -aligned, centred and right -
aligned. Vertical alignment can be at the top,
middle or bottom of the cell.

Characters can be displayed
in a range of fonts or styles of
lettering, in different sizes. The font size can be increased or
decreased quickly using the letter A shown on the right above.

Bold, italic and underline effects may also be
applied.

The general method is to select (i.e. highlight) the required cell or
group of cells. Then select the required effect from the Excel
2007 Ribbon shown above.

The three icons shown on the right and in
the Font group above enable you, reading
from left to right, to put various borders
round cells, fill cells with colour and change
the colour of text. A large variety of cell
borders is available after clicking the small
arrow to the right of the border icon, as
shown in the small extract on the right.

Arial - 10 - K A

B / U -

Borders

Bgtton Border

Tog Border

,eft Border

3.ght Border
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5 Editing and Formatting

Selecting Cells for Formatting or Editing
Selecting a single cell

Click anywhere in the cell.

Selecting a group of cells

Hold down the left mouse button and drag the cursor over the
required area of the spreadsheet.

Selecting a single row

Click in the box containing the row number on the left of the
worksheet.

Selecting a single column

Click in the box containing the column letter A,B,C, etc., (or
letters such as AA, AB, ZZ, etc.) at the top of the worksheet.

Selecting multiple rows or columns

Hold down the Ctrl key while clicking the required row numbers
or column letters.

Selecting the entire worksheet

Click in the box containing a triangle in the top A

left-hand corner of the sheet.
1

In the example below, columns C and D and rows 5 and 6 have
been selected. Once selected, any of the formatting effects, such
as letters in italics or numbers in Currency format, can be
applied to the highlighted cells.

Di

A

f.

D E

1

2 Weekly Spending
3 Weekl Week2 Week3 Week4
4 Food 49.57 41.21 51.89 49.99

5 Heating 23.42 25.48 24.44 28.89

6 Electricity 11.33 8.88 9.95 12.11

7 Rent 97.00 97.00 97.00 97.00

8 jPetrol 18.49 17.12 21.21 19.82
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Formatting Numbers
Numbers can be displayed in several
formats including whole numbers and
decimal as well currency and date.

General

Numbers are formatted using the % !68

Number group on the Home tab on the
Excel 2007 Ribbon. Select i.e. highlight
the numbers to be selected,
as discussed on the previous
page, click the arrow to the
right of General shown
above. This opens the drop -
down menu shown in the
extract on the right. The
General format leaves
numbers just as you type
them in, while Currency
format adds a £ sign and displays two decimal
digits to the right of the decimal point. The icons shown below
and under General above provide a quick way of changing the
format of numbers. Reading from left to
right, these are Accounting Number
Format, Percentage Style, Comma
Style, (for separating thousands). The icons on the right above
are Increase Decimal and Decrease Decimal, allowing you to
increase or decrease the number of decimal places.

There are many other rumber formats available including Date,
Time, Percentages and Fractions.

If you click the small arrow to the right
of the word Number on the Home tab,
shown on the right and in the
screenshot at the top of this page, the Format Cells dialogue
box opens, as shown on the next page. This provides an
alternative way to format numbers in selected cells.

Number

ABC'
123

12

General
No specific fcrmat

Number
49.57

Currency
£49.57

places i.e. two

% 68

Number
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5 Editing and Formatting

The Format Cells dialogue box shown below provides tabs to
alter the formatting of a spreadsheet. Apart from different number
formats, you can also change the fonts, cell borders and fill
colours.

kraut Cells

teeter 1-Aggnrner-Itt Font

C4teQat Y:

COW 41 Sample

Monger

Border Fi I PrOLec4

ACCOaltIrp ()twit places;
Date
Tine Symbol:
Percentage
fraction begative marten:
Scieligfic
Text i1,234 .10
Spacial I 1,2$1.14
Gown -(1,234.10

In the example below, Column B is in the General number
format, Column C is in the Accounting format, D and E are in
the Currency format. Column F has been set to have no figures
after the decimal point. The numbers in column F have been
inclined using the Orientation feature in the Alignment tab
shown in the Format Cells dialogue box above.

i

2 Weekly Spending

3 Week Week) Week3 Week4 0-4

4 Food 49.37 t: 41.21 £51.99 £49. 419

1
6 Healing 21.42 £ 25.40 £14.44 LA. e
6 Eleciricity 11.9.9 £ WM £9.95 £11.11 4,11'

7 Rerei 97 £ 97.00 £97.00 £97. 446%
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Exercise 3: Formatting a Spreadsheet
This exercise covers those features of Excel 2007 which
allow you to change the appearance of a spreadsheet. All
of the necessary skills are described in the previous
pages. If you need help with a particular task, please refer
back to the relevant section.

1. Reload the spreadsheet completed in Exercise 2,
which you may have saved with the suggested name
of Spending3.

2. Make a printout showing all the formulas used to
calculate the Total spending column.

3. Display the data in the Weekl, Week2, Week3,
Week4 columns to two decimal places (e.c. 247.87).
The figures in the Total column should be displayed
without decimal places.

4. Change the font style, letter colour, cell borders and
fill colours throughout the spreadsheet.

5. Save your spreadsheet with a name such as
Spending4.

6. Print a copy of the spreadsheet on paper.

That completes all of the basic spreadsheet skills. Or the
next page there is a checklist of skills; you may wish to
complete this list to assess your personal progress.
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Checklist of Spreadsheet Skills

Open a new spreadsheet

Enter text

Enter numbers

Enter formulas by typing in a cell

Enter formulas by selecting an Excel 2007 function

Use replication

Edit numbers and text

Edit formulas

Delete rows and columns

Insert rows and columns

Change the width of columns

Change the alignment of text and numbers

Change the style and colour of cell contents

Apply different number formats such as Currency

Save a spreadsheet as a file on a hard disc

Retrieve a saved spreadsheet from a hard disc

Print a spreadsheet on paper

Display and print formulas
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6
Excel Graphs and Charts

Introduction
Graphs and charts allow numbers to be analysed and compared
at a glance; trends can be spotted and predictions made about
the way things may develop in the future. Drawing graphs and
charts by hand can be quite a difficult and time-consuming
process; programs like Excel 2007 reduce the drawing of all
sorts of graphs to a cuick and simple operation involving a few
clicks with the mouse. The basic method is as follows:

The data to be used in the graph or chart is entered
into an Excel spreadsheet.

The numbers and labels to be "plotted" are selected
i.e. highlighted in the rows or columns.

The type of graph or chart required is selected from
the wide choice available on the Excel 2007 Ribbon;
for example, p e chart, column graph and line graph.

Excel works ou` the scales for any horizontal and
vertical axes and immediately draws the graph.

Labels, titles, etc., can be added easily and the
graph or chart is saved as part of the spreadsheet.

The graph or chart can be printed separately.

The graph or chart can be inserted into a report or
other document in a word processor.

This chapter describes the use of Excel 2007 to create the main
types of graphs and charts. Also explained is the insertion of a
chart into a report in a word processor and printing a chart on
paper. A practice exercise is included at the end of the chapter.
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Types of Chart
The Pie Chart

The pie chart shows how
different items in varying
quantities contribute to a total.
Various options are available to
label the slices of the pie,

including displaying the name of
each item in the slice and the
percentage of the total. A
separate legend or key to the
colours can also be displayed.

The Line Graph

The line graph shows how a
quantity varies over a period of
time. The time in weeks, months
or years, for example is

normally plotted along the
horizontal scale with the
quantity being measured on the
vertical scale.

The Column Chart

This chart is useful for
comparing quantities side by
side; for example to compare
the total weekly sales of
different bar meals. You can
alter the range of the scales
and edit and format the titles,
labels and text and background colours.

The methods for creating each of the above charts and graphs
using Excel 2007 spreadsheets are discussed in more detail in
the remainder of this chapter.

Garden Birds

Body Mass Inde

Total Weekly Sales
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Drawing a Pie Chart
The data for this simple pie chart
is entered into Excel 2007 as
shown on the right.

You can apply some colours to
the text and backgrounds by
clicking in the headers at the top
of each row and on the left of
each column. Then select a font

colour or a fill

colour from the Font
Ribbon with the Home tab selected.

Now, keeping the left mouse
button held down, drag the
cursor from cell A3 to cell B7,
so that all of the data is

highlighted, as shown on the
right. Do not include the titles in
the selection area at this stage
- they can be added later.

A

1 Garden Birds
2 Bird Number
3 Chaffinch 5

4 Blue tit 7

S Sparrow 9

6 Starling a

7 Blackbird 7

group on the Excel 2007

A B

1 Garden Birds
2 Bird Number
3

4

6

7

Chaffinch 5

Blue tit 7

Sparrow 9

Starling a

Blackbird 7
Now click the Insert tab on the
Excel 2007 Ribbon; as you can see on the Charts group below,
there are icons for the various types of graph and chart such as
Column, Line, Pie and Bar, etc.

ji 'tome Insert Page Layout Fonsulas

Garden b,vds.x$vr - Microsoft Lir el

PerotTable Table

L' ALAI
Clip Art

..,;) Shapes -
Picture Column Line Pit

Ar" SmartArt

DM1 Review 'el.*

Tables Illustrations

Bar Area Scatter

Charts
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Now select the Pie icon from the
Ribbon shown on the previous
page and you can choose
between various types of pie chart,
as shown in the extract on the
right. Click the type of pie chart you want and it instantly appears,
embedded in the spreadsheet, as shown below.

24) Pie

1

2

3 r Chaffinch
4 Bluetit
5 Sparrow
6 Marline
7 Blackbird
8

9

10

11

12

13

14

15

16

17

18

19

20

21

A

Garden Wok
Bird Number

5

7

9

a
4

 t hstfirct.

Blur tit

SpN,Ow

Stibt brig

ci

As shown above, Excel 2007 has included a
legend or key to the right of the pie chart. This
shows the colours Excel has used for each bird
or slice of the pie. If you want to change the
colour of a slice, click the slice twice very slowly - not a normal
double-click. Three small circles appear on the slice showing it is

selected. Now change the fill colour of the slice using
34 the fill icon, shown left, found

in the Font group on the
Home tab of the Excel 2007 Ribbon. In
the example on the right, the Sparrow
slice has been changed to yellow.

 Chaffinch

 Blue tit
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Pie Chart Styles

If you click the Design :ab while an Excel chart is highlighted in
the worksheet, a huge choice of designs appears. These appear
across the Ribbon in the Chart Styles group, as shown below.

111: 1I

The scroll bars on the right of the Chart Styles group above
display many more sets of pie chart des gns. The Garden Birds
pie chart is shown below with one of the above Chart Styles
applied.

Home Insert i.,4e Ferri,

al JT
Change Save as Switch Select Quick

Chan Type TemplMe RowCokann Data Layout 
Type Data Chart layout

41

Chart 14 it y:Li
A B C D E F G H

Garden Birds
2 Byrd

3 e Chaffinch
Blue tit

5 Sparrow

6 Starling

7 Blackbird

10

11

12

13

14

15

16

17

18

19

20

21

Number
5

7

9

8

4
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Changing the Layout of a Pie Chart

The Quick Layout feature in the Chart Layouts group on the
Design tab on the Ribbon presents various options as shown on
the left below.

Formulas Data Review View Design Layout

11 id I

Quick
Layout -

lj
Chart Styles

Options on the Quick Layout
menu include the labelling of
each slice as a percentage and
hiding or displaying the legend,
as shown on the right. The
legend can be placed in various
positions and these options are
shown in full when you click
Legend on the Layout tab of the
Ribbon. You can also replace the
default Chart Title with your own,
such as Garden Birds shown on
the right. The Quick Layout
options also include displaying
the data labels (Chaffinch, etc.,)
inside of the slices as shown on
the right. More options for the
placing of data labels are given
after you click Data Labels on
the Layout tab on the Ribbon.
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Garden Birds

Star 1,ng
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Updating a Chart
When a graph or chart is embedded in a spreadsheet as shown
below, there is a live link between the data in the cells of the
worksheet and the chart. If you make a change to the numerical
data or a label in the spreadsheet, the graph or chart is

automatically redrawn to reflect the new data or label.

INN Intal Rao t layout Fonoulas Data Prot% New Deston layout Fame

Chariot Sine as Svatch Sated Quota 1110
Chart Type Template Row Column Data Layout

Type Data Chart tryouts

Chat 1.5 b
Gardon Buds

2 Bard %union'
1 e Chafhnech

4 Slue tr
5 Sparrow

6 Starting

7 Siackbord

9

10

11

1.2

1.3

14

1.5

16

17

La

19

B

Garde i Birds

ISIOCYaird "" "r "
19%

74Marrone

25%

tpl

In the above example, the number for the Blackbird in cell B7 is
increased to 7. The pie chart is automatically adjusted to show
he new slices with the Blackbird slice increased to 19% from
12% as shown on the previous page.

Saving a Graph or Chart
Save the spreadsheet using Save or Save As from the Office
Button menu as previously described. The graphs or charts will
be saved on the hard disc as an integral part of the spreadsheet.
When you later retrieve the spreadsheet from the hard disc, any
graphs or charts will open up on the worksheet as shown above.
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Drawing a Line Graph
The spreadsheet below shows a person's weight as they follow a
dieting program for six months from January to June. Body Mass
Index (BMI) is a measure of a person's weight in relation to their
height; a BMI above certain limits suggests that a person may be
classified as obese. The formula used to calculate BMI is as
follows:

BMI = Weight in Kilograms
(Height in Metres) x (Height in Metres)

The Height squared i.e. multiplied by itself, is obtained by
entering the formula =C4*C4 in cell D4. This is replicated down
column D by dragging the small cross from the corner of cell D4.

B C D

Body Mass Index (BMI)

2

3 Month Weight kg Height (M) Height Squared (M:) BMI

4 Jan 79 1.6 2.56 30.86

5 Feb 75 1.6 2.56 29.30

6 March 72 1.6 2.56 28.13

7 April 71 1.6 2.56 27.73

8 May 68 1.6 2.56 26.56

9 June 64 1.6 2.56 25.00

We could miss out column C and D and simply enter the formula
=B4/(1.6*1.6) in cell C4 since this person's height will always be
1.6 metres. However, the method in the above worksheet is more
explicit and can easily be adapted for people of different heights
and weights.

The problem now is to plot a line graph showing the months on
the horizontal scale and the BMI on the vertical scale. To do this
we first need to select or highlight the data in columns A and E
only. This can't be done by simply dragging over Column A
followed by Column E, since clicking and dragging in Column E
deselects Column A.
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Selecting Two Non Adjacent Columns

This is done by dragging the cursor down over cells A3 -A9. Then
holding down the Ctrl key and dragging over cells E3 -E9. The
extract below shows the BMI worksheet with the data and
column headings in columns A and E highlighted and ready to be
plotted.

A

1

2

3 Month

B

Weight kg

C

Body Mass Index

Height (M)

D

(BMI)

Height Squared (M2) BMI

4 Ilan 79 1.6 2.56 30.86
5 Feb 75 1.6 2.56 29.30
6 March 72 1.6 2.56 28.13

7 April 71 1.6 2.56 27.73

8 May 68 1.6 2.56 2636
9 June 64 1.6 2.56 25.00
10

Now select Insert from the Ribbon and choose Line from the
Charts group as shown below.

.11 ::.
Column Line Pie Bar Area Scatter Other

- - ' - - Charts -

Charts c.

Many different types of Line
graph are available as shown on
the menu extract on the right. This
menu drops down when you click
the Line icon shown above.
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When you select one of the line graph types shown on the
previous page, the graph appears instantly on the worksheet as
shown below.

0

,lody Mays Index (HMI

I Month W4tgh,, kx Height (M) 14m6ht Squarm1184') I !WI i

4 Ian 79 l.6 2.56 10.86

5 '.,443 71 1.6 1'56 29.10

6 March 72 1.1i 2.56 &LI
7 apnl 71 1.6

8 May 68 1.6

9 lune 64 Lli 1500

IC

1 I
10 00

U 25 00

13 20 00
14

15
15 00

16 10 00

17 500
18

000
19

20

BMI

lib Mode MM1 lbw Ma

-OM

The first drawing of the line graph
may not be what you want but it's Design Layout Format

not difficult to make modifications.
For example, you might want to al
start the BMI vertical scale at Axes Gridlines Plot

Area20.00, say, rather than 0.00 as
This can be done by Primary Horizontal Axis

selecting the Chart Area on the ei Rieman Datical Amis
worksheet and then selecting
Axes from the Layout tab on the Ribbon. Then select Primary
Vertical Axis and More Primary Vertical Axis Options.... From
the Format Axis dialogue box which appears change the
Minimum to Fixed and 20.0 as shown below.

Format Axis

kids Options

II

Number

Fill

Axis Options
Minimum:

M.Domurri: o

Au to

Ay.00

ia Fixed

Fixed

II

20.0
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Formatting a Chart
The BMI line graph is shown below, automatically updated with
the vertical scale starting from a BMI of 20.00 rather than 0.00.

32 00

30 00

28 00

2600

24 DO

22 00

20 00

Body Mass Index

Jan Feb March April May Jun*

2009

-BMI

The above line graph has been formatted in a number cf ways.
To format a chart, first select the Chart Area on the worksheet as
shown above. The icons on the Ribbcn change to show the
Chart Tools.

The above line graph has also been formatted to include a Chart
Title. Initially BMI was inserted automatically from the selected
BMI column in the
spreadsheet. Click in the
Chart Title area and type in
the new title. Each of the
areas in the chart above
were first selected and then
filled with colour using the fill icon

Home InseR Page layout Fc

-J

I

Anal ' )2  K
B / A -

on the Home tab
shown above and right. Click the fill icon then select
the required colour. The font colour in any of the text
areas can be changed after clicking in each text area
and then clicking the font color icon shown on the
right, before choosing a colour.
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6 Excel Graphs and Charts

Axis titles can be switched on or off after clicking Axis Titles on
the Layout tab in the Labels group on the Ribbon. The Chart
Title can also be switched on or off and its position altered.

"I 1.: I

N 1 ilk I ,'1
Chart Axis legend Data Data Axes Gridlines
Title - Titles - - Labels - Table -

labels Axes

Clicking the Gridlines icon above on the right displays horizontal
and vertical lines across the whole of the chart area, as shown
on the line graph below and on the previous page.

Two Lines on One Chart

As shown below, Excel can display two lines, for example,
Weight and BMI, on one chart. In the BMI spreadsheet shown
previously, select columns A, B and E, highlighting the areas
from row
Weight kg and BMI. As discussed earlier, selecting data in
multiple columns which are not adjacent is achieved by holding
down the Ctrl key while dragging with the mouse. Now click
Insert and choose the type of line graph. The graph is displayed
and can be formatted as previously described, as shown below.

'A eight Kg
BMI

BMI and Weight : Jan - June
90

80

70

GO

50

40

30

20

Jan Fob March April May June

2009

-Weight kg
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Drawing a Column Chart
This chart will be based on the Bar Meals spreadsheet shown
below.

A D E F G

1 Bar Meals
2 Meal Tuns Wed Thurs Fri Sat Total

3 Pizza 3 8 9 12 17 49

4 Cod and chips 7 6 14 23 21 71

5 Scampi 2 6 8 13 18 47

6 Mushroom Risotto 3 6 5 8 12 34

7 Coq au Vin 0 8 4 7 9 28

8 Total 15 34 40 63 77 229

A column chart for the sales Total in a week for each meal will
make it easier to see the most popular dishes. We need to select
the Meal column, Column A, by dragging the cursor from cell A2
to cell A7 only. Then keeping the Ctrl key held down, drag the
cursor down the Total column, Column G, from cell G2 to cell
G7. Next select Column in the Charts group on the Insert tab
on the Ribbon, shown below.

11.

Column Line Pie Bar

Charts

11110

Area Scatter Other
- Charts

You are presented with a choice of
many different designs for column
charts as shown in the small sample on
the right.

After you click on a column chart de-
sign, the chart immediately appears on
the worksheet, a shown on the next
page.

2-0 Column

II
3D Column

Ii
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6 Excel Graphs and Charts

Bar Meals
1.1

Meal Ttle$ Wed Thus Fri Sit leaf
Dina J2 17

I

( od and chips 23 71 71

Scampi 2 C 13 18 47
hisishinoni Pe.ollo 3 6 5 8 12

( oci dll Vin 0 0 4 7 9

,olal 15 34 00 03 77 220
9

ID

13

12 Ri
13 7D

11 60
15

SO
]6 Iii
17

30
10

21)
19

20

21

72

23

Total

Inns WOW Primp
RIR

1I
oshincer Con NI /V

The chart can now be formatted after selecting it by clicking any-
where in the Chart Area above. Formatting the column chart with
a Chart Title, Axes Titles, Gridlines and different colours for
the text and fill areas is the same as described in the previous
section for the Line Graph. The Bar Meals column chart is
shown below after adding titles and formatting.

80

70

60

50

Bar Meals

Number 40 '-
20

20

10

0

Ana
1

Cod and Scampi Ikeetiroom Coq au Yin
chips Fihogo

Meet

64



Excel Graphs and Charts 6

Changing to a Different Type of Chart
You might decide that another type of chart is more appropriate
for your data; this is accomplished using the Change Chart Type
icon on the left of the Design tab on the Ribbon shown below.

Page Layout

Change Save As Switch Select
Chart Type Template Pewit olunm Data

T,p. rr

For example the Totals for the Bar Meal sales in the previous
column chart could quickly and easily be presented as a 3-D pie
chart, as shown below. Simply click the Change Chart Type icon
shown above and select the new chart from the menu which
appears, as shown in the small extract below.

Change Chart Type

Templates

Column

Lne

Pre

-411k1.1,__ti ALA !doi
Bar

The Bar Meals Totals are shown as a 3-D pie chart below.

Mushroom
Risotto

IS%

Bar Meals

CcP
12%

--141111111""

Cod and chips
31%
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6 Excel Graphs and Charts

Drawing a Clustered Column Graph
This graph will show the sales of each meal side by side on the
different nights. It is drawn after selecting all of the meals for
every day. This can be achieved by dragging diagonally from cell
A2 to cell F7 as shown in the example below.

1

A B C

Bar Meals
2 Meal Tues Wed Thurs Fri Sat Total
3 Pizza 3 8 9 12 17 49
1 Cod and chips 7 6 14 23 21 71

5 Scampi 2 6 8 13 18 47

6 Mushroom Risotto 3 6 5 8 12 34

7 Coq au Vin 0 8 4 7 9. 28

S Total 15 34 40 63 77 229

The clustered column graph is drawn after selecting Column on
the Insert tab in the Charts group on the Ribbon. The icon for
the clustered column chart is on
the left of the group of three
shown here on the right. When
you select this icon the clustered
column graph appears, as
shown below after some formatting

25 -

%umber Sold

10

Bar Meals

'rues Wed Thurs Fri Sat

 Pizza

 Cod and chips

 Scampi

 Mushroom Risor:

 Coq au yin
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Printing a Chart
Although the chart appears to be an integral part of the whole
worksheet in Excel, the chart can be printed separately. Select
the chart by clicking anywhere in the Chart Area. Now
click Print on the Office Button menu displayed by
clicking the orb, as shown on the right, at the top left
hand side of the screen. The Print dialogue box appears as
shown below. The radio button next to Selected Chart should be
switched on, indicating that only the chart will be printed.

C!n

Print

Printer

Name: Canon LASER SKOT LOP -1120

Status: Idle
Type: Canon LASER SHOT LOP -1120

Where: 1E43002

Comment:

Print farce

O All

Page(s) From: To:

Prnt what

Selection Enure workbook

 Selected Chart Table

Ignore Pint wee*

Pyorerues- I

Find Printer...

Copes

Number of copes:

5 3 3

Print to file

Cvlate

OK Cancel

Click the OK button above to commit the chart to paper. To print
both the spreadsheet table and the chart, don't select the chart
on the worksheet. The Print dialogue
box will then show Active Sheets, as
shown on the right. If a chart or
spreadsheet is too wide for the paper,
switch to Landscape Orientation after
selecting Properties shown above.

Prnt vehat

!.;elet bon

o Ac bye sheet(s)

Ignore arrit areas
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Inserting an Excel Chart into a Report
A report produced in a word processor such as Word 2007 can
be illustrated by inserting graphs and charts from Excel 2007. In
earlier times this would have to be done by drawing the graphs in
by hand or perhaps by literally cutting and pasting with scissors
and glue. As discussed shortly, the electronic process of
inserting an object is still called "cutting (or copying) and pasting"
although now it's all accomplished with a mouse and keyboard.

The word processor document should be open and minimised on
the Windows Taskbar at the bottom of the screen. The Bar
Meals spreadsheet should be displayed on the screen with the
Chart Area selected and highlighted as shown below.

1

z Mid

C

Bar Weds
0 I P 0

Viedhes Wed livws MA ern
1 Pim 1 6 1 12 1 10

4 Cod awl chips 7 6 IR 21 21' rt
5 Scampi 2 6 11 LI VS [7
1 leuthroorn Risotto
1 cnaid Sin

1

0

4

a

1 $ 12

6 901141 IS sa Bar Meals
I
10

ll
40

 o colU
14 Sold

11
 Cod old door.

1

lb
17

Ls

 Parilonse. 0,30.
 Coo. din

19

20

21

en vd,0 S.*

Now from the Home tab on the Excel 2007 Ribbon, click the
Copy icon shown highlighted below the scissors on the
Clipboard group shown below.

Home

Paste

Clipboard

Insert Page layout Formulas Data

CAW' (Body) - 11) ' A A I1imiigpp
B I U - - A - mil :#

Font Alignment
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This places a copy of the Bar Meals Chart on the Clipboard, a
temporary storage area from where it can be pasted into another
program such as the Word 2007 word processor.

If the report is already open in the word processor but minimised,
open the report on the screen by clicking Bar Meals Review on
the Windows Taskbar as shown below.

Pagel 111 018 Words: 2,340 0 English (United Kingdom)
)) eirgarMealsvie...

Otherwise launch the word processor and open
the report with the cursor placed roughly where
the top left-hand corner of the chart is to go. Now
click the Paste icon on Home tab on the Word
Ribbon. The chart is pasted on to the report as
shown below. In Word 2007 you can adjust the
final position of the chart by
selecting the Format tab and
choosing a Position as shown in
the small sample on the right.
Otherwise the position of the chart
can be adjusted by dragging with the mouse.

With Text Wrapping

La, Mull/ Felts
The hotel fir47.11.1y tunte. tfr.7aF :Dab m ibt bir
as the etlItglig boon Samardry. Thee wt
;weroir.r. so t>Q %-ery popthr z !WPM try the /net
below

ear arils

I 
 ....0,

% 0. -

uor.,th be repined, 6mcies1 )»lisc.rol u the
uoreiremd 1etf. ut 1st rolmott We Ca.
sorb, utath tangy u> he' bum 4.1rerev/sair4
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6 Excel Graphs and Charts

Exercise 4: Excel Graphs and Charts
The table below shows second-hand car sales in a
dealer's.

Make July Aug Sept
Ford 7 9 6
Peugeot 5 5 3
Toyota 8 4 7

BMW 3 4 2
Honda 4 5 4
Renault 2 3 5

1. Enter the above data into an Excel worksheet

local

Add an extra column, Total, after September and
complete this column using the Excel SUM function
and replication.

Save the Excel worksheet.

Create an Excel pie chart showing how :he sales of
each make of car contribute to the total sales.

5. Print just the pie chart without the spreadsheet table.
6. Create a clustered column graph showing the months

along the horizontal axis with columns for all of the
makes, as shown below. (You may need to click
Switch/Row Column on the Design tab).

10

9

$

6

Cars Sold S

4

3

2

1

MonthlyCar Sales

hdY August September

 Ford

 Peugeot

 Toyota

 BMW

 Honda

 Renault
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7
Using Excel as a Database
Introduction
The main use of spreadsheets is to automate calculations on
large tables of figures and enable charts and graphs to be drawn
easily. However, the layout of the spreadsheet in organized rows
and columns makes it very easy to enter and create on disc a
simple database such as a file of names and addresses. Once
entered and saved in Excel, the names and addresses can
easily be updated by amending details or adding new people.
Excel 2007 also allows the sorting of records into order and the
filtering of records containing particular information. This might
for example, be useful for:

The secretary of a club, group or society keeping
membership details and sending out regular
newsletters.

A business sending out invoices, special offers, etc., to
customers and clients.

An organization wishing to keep personal details of
staff or students, etc.

Anyone sending out a lot of invitations, greetings or
Christmas cards, etc.

An Excel address file may be used as the data source for
importing a large number of names and addresses into a mail -
merge program in a word processor such as Microsoft Word
2007. This allows address labels to be printed very quickly,
saving a great deal of time compared with manual methods.
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7 Using Excel as a Database

Creating an Address File in Excel
From Start, All Programs and Microsoft Office, select
Microsoft Office Excel 2007 as previously described.

After you've used Excel the first time it can subsequently be
launched directly from the main Start menu. Excel opens ready
for you to start entering the column headings, such as First
Name, Surname. Address Line 1. Address Line 2, etc., as
shown in the extract below. The column headings First Name,
Surname, etc., play an important part in the mail merge, as will
be seen later.

4 F int Name Surname Address Line 1 Address Line 2 Address Line 3
5 John Walker 19 L ondon Rd Lewes F Susses

6 Susan Slater Finfrifield Milmch St one

7 JON AAISi M Hinckley Farm Ractbourne Derby

8 Robert Burns 14 Belmont Rd Miura yfield E dinburgh

9 Sarah Michell Salmon Leap I India m I Jorthurnherland

10 Bob Smith 71 Church St Greenwich London

1: Mike Brunt 83 Valley Rd Thetford I forlolk

11' Jean Baker VVesl wad Weaver View ic Midi!

1., Samuel Johnson The Collage Great Cubley Ashtourne

You'll probably need to extend the width of the columns to
accommodate the column titles and also the data. To do this,
allow the cursor to dwell between the column headers. The
cursor changes to a small cross, shown between D and E below.
The cross can then be dragged to give the correct column width,
while holding down the left mouse button.

D

Address Line 2 Address Line 3

Entering the Data

It's simply a case of typing the names and addresses into the
cells. Don't use commas or punctuation marks within an address
field: "83, Valley Rd'', for example, might cause problems. To
move to a new cell press the Enter key to move down and the
Tab key to move across.
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Using Excel as a Database 7

Text can be formatted in the cells in Excel in a similar way to text
in a word processor; the Ribbon in Excel contains the usual text
formatting tools, bold, italic, underline, etc., as shown below.

Paste

Anal - 12 A

W / g - - - A -

To edit the data in a cell. double-click the cell. To format an entire
row or column, first click the row or column header (1, 2, 3, etc.,
and A, B, C, etc.,) to select the row or column.

Saving the File of Names and Addresses
Click the Office Button in the top left-hand corner of Excel and
select Save As from the drop -down menu. The file is
saved as an Excel Workbook with the file name
Address List.xlsx in this example, entered in the File
name slot, as shown below.
r Save A:

I Documents

Pr, ent Places

 'Mop
116 rnputer

PKtutes

nl Mos.,

More

Folders

Hang Gliding C

Fsle 0,.mc Address

Name Date nrochhed

lE:jAddress

Type

Save as type Excel Workbook ('A't)

Sa,e Thumbnail

rag: Add e lag

- 1-hde Folder; Toots Sem C..ancal
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7 Using Excel as a Database

Make a note of the location where the address file is saved; you
will need to browse for this file shortly when you carry out the
mailmerge in Word 2007. In this example I have used the New
Folder option, shown above on the Save As menu bar, to create
a folder Hang Gliding Club. The full path to the data source for
the mail merge is therefore:

C:\Hang Gliding Club\Address List.xlsx

Sorting into Order
To sort the address file into a particular
order, such as alphabetical order of
surname, drag the cursor over the names
so that they appear highlighted. Don't
include the column label or it will appear
somewhere in the sorted list. Now select
Sort & Filter from the right of the Fxcel
Ribbon on the Home tab. From the drop -
down menu shown on the right, choose
the order you want to sort into, such as A
to Z. A Sort Warning then appears from
where you should select Expand the
selection and click Sort. Alternatively click Custom Sort... then
choose the column you want to sort on from the drop -down menu
as shown below.

Sort & Find Z.
Filter - Select 

)1 Ion to Z

/A1 S2rt to A

.y3 Cgstom Sort...

(= Filter

11 add level )c Qelefe Level II 4,11 cepy Lewd sty mt. Mc. tear**,

Column Spa Order

Sart bY Sumas* *Kos A is CI
Fnt None

Address Lre 1
Address Line 2
Adders Lne 3
Address Lne 4
Address Lne S

OK
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The address file is shown below. with the records sorted into
alphabetical order of surname.

4 First Name Surname Address i_ine 1 Address I. ine 2

5 Jill Austin Hinckley Far -n Radbourne

6 Jean Baker West mead Weaver View

7 Mike Brunt 83 Valley Rd Thetford

8 Robed Bums 14 Belmont Rd Murrayfield

9 Samuel Johnson The Cottage Great Cubley

10 Sarah Mitchell Salmon Leap riorham

11 Susan Slater Highfield Mdwich

12 Bob Smdh 71 Church St Greenwich

13 John Walker 19 London Rd Lewes

An address file might contain hundreds of records and great
savings in time can be made compared with sorting manually.

Using an Excel Filter
If you select Filter from the
Sort & Filter menu shown on
the previous page. you can
remove certain records from the
file. A small arrow appears at
the top of each column. Clicking
this displays a list of the data in
the column; to remove a record
from the file simply click in the
box to remove the tick. In the
example on the right. when you
click OK the records for Bob,
Mike and Sarah will be

temporarily removed from the
address list. These records can
be reinstated later if required
using Clear Filter from the drop
-down menu.

F

5 1.1111

)1 Soft AtoZ

StutZto A

Sort by Color

7,4 Filters

 ;Seitect Al)
Bob

)ean

ie John
Mike

iro Robert

ro Samuel

Austin

r canc;r7
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7 Using Excel as a Database

Find & Select
This feature is found on the right of the
Excel 2007 Ribbon on the Home tab.
Find & Select allows you to quickly find
certain text or cells with certain formatting
such as italics or text or fill colour. The
cursor jumps to each occurrence of the
formatting and allows you to change it.

z -
1-
_L-

Sort & Find &
Filter - Select 
Fditinn

specified text Or

Find and Replace

rFind Raalaoe

Fed what: NM No Format Set

Wilton: Sheet

`zeardi:

Look

8y Rows

Formulas

H
H

- Match case

Match entire cel ortents

Ft.

Fvld Med aose

For example, entering the word Salmon in Find what: shown
above, quickly moves the cursor to that cell, allowing it to be
edited. Clicking the Replace tab above allows you to move to all
occurrences of the specified text or formatting: these are
replaced by the text or format in the Replace with: bar.

Find and Replace

Find Replace

Find what:

Replace with:

Salmon

Salmonidae

Replace Replace Find Al
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Using Excel as a Data Source
The address file just described can be used to infill names and
addresses into a standard letter and to print address labels.

The standard letter, or mail merge, involves sending the same
basic letter to many different people; each copy of the letter is
personalized for individual recipients, so that one letter might
start "Dear Mike" while another would begin "Dear Jill", together
with their corresponding addresses.

There are two main components of the mailmerge:

The basic skeleton of the letter which is the same for
everyone.

A list of names and addresses saved as a separate file,
often referred to as the data source.

The list of names and addresses is first created and saved as a
separate file in Excel 2007 as previously described.

After creating the Excel file, the basic letter is then typed in Word
2007, including a set of placeholders or mail merge fields. These
are marked locations in the standard letter into which the
individual names and addresses will be placed.

The mailmerge then takes place, during which individual names
and addresses are copied from the Excel file into each unique
copy of the letter. Finally the individual letters are printed.

The place holders in the standard letter must correspond exactly
with the column headi'igs in the Excel worksheet, i.e. First
Name, Surname, Address Line 1, Address Line 2, etc., as
shown in the extract below.

A B C D

3 First Name Surname Address Line 1 Address line 2

4 Jill Austin Hinckley Farm Radbourne

The above column headings are shown in position as place
holders in a standard letter on the next page.
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7 Using Excel as a Database

High Peak Hang Gliding Club
Roaches House
Leek
Staffordshire
ST6 5 BY

29 June 200S

oFirst_Name» oSurname»
«Address_Line_1»
oAddress_Line_2»
oAddress_Line_3))
oAddress_line_40
oAddress_Line_50

Dear «First_Name»

National Over 50s Hang Gliding Championship
This year we will again be fidding a team in this prestigious event; if you
would like to be considered far selection, please reply to me by letter at the

The position of the above place holders can be adjusted by
dragging to give the layout you require. Word 2007 then allows
you to preview the letters with the individual names filled in

before printing on paper.

Printing Name and Address Labels

The Excel 2007 address file can
also be used for printing address
labels in Word 2007. A4 sheets of
sticky labels are available and
these have a reference number,
such as Avery L7163. This is

entered into the Word Labels
feature and the Excel place holders
are applied to the labels. Once set up the Mail Merge feature
can easily be used to print hundreds of labels using an Excel
2007 spreadsheet as the data source.

.First Name erSumame.

.Address_Line_ 1

.Address_Line_2

.Address_Line_3,.

.Address_Line_4>wAddress_Line_:

,Next Record.,
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Managing Excel Files

Saving an Excel File
An Excel spreadsheet (called a workbook) is saved on a hard
disc using Save As from the Office Button menu discussed
earlier.

Save As

0 \....)01 Eacel 2007 spreadsheets

Documents

Recent Places

 Desktop
;1111 Computer

ir Pictures

it Music
More n

Folders

Name Date modif... Type

61.1Bar mealsAsx

,'1.1Dnnk Sales Ncrvember.vlsii

,:jSpending.alsz

File Dame Garden birckdloi

Save as type bad Workbook ("An)

Authors Jim Tags Add a tag

Save Thumbrail

Hide Folders Tools n

Tee

a. 1

You make up a name for the file, such as Garden Birds, and
type it in the File name slot shown above. In the above example
the folder name Excel 2007 spreadsheets was selected by
browsing the hard disc after clicking Computer shown on the left
above.
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8 Managing Excel Files

Creating a New Folder
To make a new folder, first select the location where the new
folder is to reside. This might be at the top level on the C: drive
(hard disc) or within another folder. Click Computer shown
previously, find the required location and click New Folder.

174 Save As

4e Links

IF Documents

1111111X2111111111=
HP_PAVILION (C4 Spreadsheets 't

Name Date modified Type

Excel 2007 spreadsheets

ew Folder

In the example above a new folder is being created within an
existing folder called Spreadsheets. Overtype the words New
Folder with your own name. If the new folder were called
Accounts. for example, the address or path to this folder would
be C:\Spreadsheets\Accounts.

File Types

An Excel 2007 spreadsheet is, by default. saved as an Excel
Workbook as shown below. You don't need to type in the file
name extension, .xlsx - it's added automatically.

F ik name Garden birds.xlsx

Save as type !Excel Workbook ('.xlsx)

Although most users will probably only use the Excel Workbook
(*.xlsx) format for saving files, many other formats are available
after clicking the arrow on the right of the Save as type: bar
shown above. These include the popular PDF (.pdf) or Portable
Document Format used for Internet files and also several
formats compatible with Apple Macintosh Computers.
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Managing Excel Files 8

Locating an Excel File
After you click the Save button on the Save As dialogue box
shown previously, the Excel file is stored on your hard disc in the
location, i.e. folder, which you specified. It's a good idea to try to
create a logical system of folders with meaningful names so that
you can easily find a spreadsheet, perhaps weeks or months
after you created it.

To locate a file, first double-click Computer on the Start menu
(Windows XP users should click My Computer), then browse on
the appropriate disc drive, usually C:, for the required folder.

Folders v Marne Type Total Site Free Space

II Desktop Hid Disk Dnves 12)

11:1 km HP DAMON (C) 0)) HPPECOVERY (a)
Public

. '...."..1(0-2. Computer

Files representing some of the small sample spreadsheets
discussed earlier in this book are shown below in the Computer
feature; in this view the file name and file name extension (.xlsx)
appear alongside of the Excel 2007 icon.

'1. 4110 a Computer a HP PAVILION (Ci) a Spreadsheets a Excel 2007 spreadsheds

dv.7..re TeMP; "

Folders v Name Date modified Type Site

El Desktop . Bar mealsskr Btlbra.
ct hns

2.

Publac

.f1 Computer
..

Garden birdsalsi Spending.ii,

,2, Floppy Disk °nye (&) ..i

2. HPPAVIJON (C:1

Taqs

From the above extract from the Computer window you can see
that the full path to a spreadsheet file such as Garden Birds is:

CASpreadsheetslExcel 2007 spreadsheets\Garden birds.xlsx
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8 Managing Excel Files

Viewing Files in the Computer Window
The Views menu shown on the right allows
you to display the Excel files in several
different ways, including different sizes of
icons up to Extra Large. If you want to find
out more about the files, select Details from
the Views menu on the right. The Computer
window, as shown below, then displays the
date and time when a file was last modified
(or created, in the case of a brand new file).

aC Extra Large Icons

Large Icons

s'; Medium Icons

.; Small Icons

List

Details

Computer  HP_PAVAION (C,) r Spreadsheets a Excel 2007 spreadsheets

fee Erkt Yoe.. tool; Help

-

Folders

Desktop

lem

O ubk

Or Computer

Noppy Desk Dove (0)

 HP _PAVIION (C :I

v Name Date modehed type

.,Bar meals -else 07/11;200811.43 Atecrosolt Offer e

"ABIALdsa 06/11/2008 11,47 Men:Koff Offer e

OA Donk Sales November-. 02/11/200808..42 MK rosoft 011era E...

',Garden berdsAss 07/11/2038 10-25 Mu 'molt Cala e

623Spendintydsa 28/10/200806:44 Murosoft Office E...

Sae

13 KB

13 KB

100.8

12 KB

13 KB

The date and time when a file was last modified is useful
because you often need to make sure you are working with the
latest version of a file, copies of which may be stored on several
different computers. The spreadsheets listed above can be
sorted into alphabetical order of Name. Date modified or Size.
This is done by clicking the title of the column such as Name or
Date modified. In the example below the files have been sorted
by Date modified.

Folders

Desktop

la Jim
Public

as Computer

Floppy Disk Drive (A:)

HP_PAVILION (C:)

Name Date modified

Spending.xlsx 28/10/2008 06:44

IE Drink Sales November.... 02/11/2008 09:42

CALIBMI.xlsx 06/11/2008 11:47

Ell Garden birds.xlsx 07/11/2008 10:25

'L.) Bar meals.xlsx 07/11/200811:43

CI] Bookl.xlsx 10/11/2008 11:22
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Common File Management Tasks
There are many tasks which are otter needed on files in the
Computer window, such as copying moving, deleting and
renaming. As usual Windows Vista provides several alternative
methods to achieve tie same task. For example, there are two
Menu Bars on the Computer screen, which both have menus to
carry out basic file management operations. These are the Edit
and Organize menus on the two Menu Bars shown below.

41111,

Organize Views Burn

Computer HF_PAVILION (C:) Spreacsheets Excel 2007 spreadsheets

Folders

 1111 Desktop

CI Jim
Public

 Ai, Computer

v Name Date Medd.. Type

Spencling.xlsx Drint Sales BMLr
November...

Size

Garden
birds.dsx

Right -Click Menus

A very quick and easy way to access
Windows menus is to r ght-click over the
file name. This displays the menu shown
on the right. (Right -click menus are
available in Windows programs in

general).

Clicking Norton 360 allows you to scan
the selected file with the well-known anti-
virus and Internet security program.
Rename, not surprisingly, allows you to
type in another name for the file.

Properties of an Excel file are discussed
at the end of this chapter. Common tasks
on the file name right -click menu are
described on the next page.

Open
New

Print

Open With

(e) Norton 360

Send To

Cut

Copy

Create Shortcut

Delete

Rename

Properties
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8 Managing Excel Files

Open

Opens the selected spreadsheet in Excel 2007. A file can also be
opened in Excel by double-clicking the file name.

Print

Opens the selected spreadsheet file and prints a copy on paper.

Send To

Allows you, for example, to copy the file onto a CD, send it in an
e-mail and place an icon for the file on the Windows Desktop.

Copy

Places a copy of a selected file on the Windows Clipboard; a
copy of the file remains in the original location. To copy the file to
another folder, right -click over the new folder in the Computer
window. Then select Paste from the menu which appears.

Cut

Removes the spreadsheet file from the current folder and places
a copy on the Windows Clipboard ready to be pasted into
another folder as described above.

Create Shortcut

Places an icon for the file on the Windows Desktop. Double-click
this icon to quickly launch Excel with the spreadsheet file open.

Delete

This removes the selected file to the Windows Recycle Bin.
(From where it may be retrieved if the bin hasn't been emptied).

Using Drag and Drop

Files may also be copied or moved in
the Computer window by keeping the
right-hand button held down and
dragging the file icon over the new
folder. Release the right-hand button
and select Copy Here or Move Here
from the pop-up menu.

Copy Here

Move Here

Create Shortcut; Here

Cancel
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Properties of an Excel File
To find out more details about a particular file, highlight the file in
the Computer window as shown on the previous page, then
select Properties off the Organize menu. The Properties
window opens as shown below, in this example displaying the
details of the Bar meals spreadsheet discussed earlier.

Bar meals.xlsx Properties

General Security I Detads

Bar meakodsx

Type c fie: Microsoft Office Excel Worksheet (Atm)

Opens with: 11;1 Microsoft Office Excel

Location:

Size:

Size on disk :

C:reated.

Modrfied:

Ar:cier:r.ed:

Attrtbutes:

Change--

CABabeni \Books \BP701 Excel Spreadsheets \Exce

12.3 KB (12.692 bytes)

16.0 KB (16.384 bytes)

05 November 2008. 10:42:28

02 December 2008. 11:02:27

02 December 2008. 11:02:27

Read-onlyi Hidden Advanced._

OK Cancel
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8 Managing Excel Files

Read Only Files

If you were worried about accidentally deleting a copy of a very
important file you could set it to Read-only, as shown on the
Properties window on the previous page.

Hidden Files

If you have some Excel files which are confidential you can hide
them so they are not listed in the Computer window shown
earlier. Anyone who knows the name of a hidden file can still
open it in Excel after clicking Open on the Office Button menu
and typing the file name in the Open window.

To hide a file, first click the square next to Hidden, as shown on
the Properties window on the previous page and then click
Apply and OK. Now click Tools on the Computer Menu Bar and
select Folder Options... as shown below.

Computer  HP PAVILION (C:) Spreadsheets

File Edit View

rga tze

Folders

Jill

Jills pho

Help

Map Network Drive...

Disconnect Network Drive...

Open Sync Center...

Folder Options...

Next select the View tab in
the Folder Options dialogue
box and make sure Do not
show hidden files and
folders is switched on as shown on the right. Click Apply and
OK and the hidden file will not appear next time the Computer
window is opened. Only people who know the name of the file
will be able to view and open it using Open off the Office Button
menu in Excel 2007.

Hidden hies and folders

Do not show hidden Soo and folders
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9
Safety Precautions

Introduction
After using Excel 2007 for a while you'll probably have created
some large and useful spreadsheets and saved them as files on
your hard disc. These files may contain important financial or
confidential personal data. Unfortunately there are many ways
that spreadsheet files may be lost or damaged, for example:

You might accidentally delete the wrong file or a
malicious person might delete files deliberately.

You can easily delete the latest version of a file in a
"drag and drop" operation by accidentally overwriting
the new file with an older version.

A powercut, electrical surge, spike or computer error
might damage files which are currently in use.

You can damage files which are currently open if you
don't follow the correct procedure to shut down your
computer.

You might forget the location on your hard disc where a
particular spreaisheet file was saved.

A file may be corrupted, requiring the hard disc to be
reformatted so that all of your data files, including Excel
files, are wiped.

Fortunately there are many effective and inexpensive ways to
safeguard your Excel files and these are discussed in the
remainder of this chapter. (External threats to your files are
discussed in Chapter 10).
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9 Safety Precautions

Making Regular Backups
If you've spent a lot of time building large Excel files, it's essential
that you make backup copies. These should be on a separate
removable storage medium such as a CD, DVD or flash drive.
Making a duplicate copy of a file on the same hard disc is of little
use if the computer or hard disc is stolen or damaged. The
backup copy should be kept in a different physical location from
the computer. Should the original copies of your Excel files be
lost, you can restore the backup copies and continue working.
Otherwise you may be faced with retyping entire spreadsheets.

Backup Media

For the home or small business user, cheap media such as CDs
and flash drives have simplified life considerably. Below is a
backup procedure which has served me well in the production of
numerous books using Word files - so far avoiding the loss of a
single file. Backing up Word files is essentially the same as
backing up Excel spreadsheets.

Regular daily backups of current work in progress are
copied onto a removable USB flash drive, which is

overwritten each day with the latest file. The flash drive is
much faster and holds much more data than the floppy
discs formerly used.

Weekly backups are copied onto CD -Rs, which now cost
only a few pence each. One CD -R can easily store
several books like this one and very many Excel
spreadsheets. Files on a CD -R cannot be deleted.

Checking that a Backup File is Retrievable

It's always a good idea to check that the backup was successful
by opening the copies of the files from the backup medium. This
can be done from within Excel using Open on the Office Button
menu or by double-clicking the file name in the Computer
window as discussed in Chapter 8.
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CD Writing or "Burning"
Earlier versions of Microsoft Windows did not include CD writing
or "burning" software, so it was necessary to purchase a third -
party product. Two of the most popular packages are Easy CD
Creator from Roxio and Nero from Ahead Software. The CD
burning software built into Windows Vista is an extremely useful
backup tool and now includes the ability to write data on DVDs.

Using Windows Vista's CD/DVD Burning Software

The method of copying files to a CD or DVD is basically the
same and is described on the following pages. First a blank disc
is placed in the drive and after a very short time the AutoPlay
window opens as shown below. From this window select Burn
files to disc.

 AutoPlay

V,D D RW Drive (E:i
_61261

Always do this for blank DVDs:

Blank DVD options

CIBurn a DVD data disc

'mar*

4. Bum files to disc
I using Windows

0 Bum a DVD video disc
using Windows DVD Maker

Set AutoPlay defaults in Control Panel
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The following Burn a Disc window appears, with a drop -down
menu allowing you to choose a formatting option for the new
disc. To open this menu click the arrow next to Show formatting
options. If you are using a CD -R disc which can only be written
to once, click the radio button to the left of the word Mastered
shown below.

Burn a Disc

Prepare this blank disc

Disc title: Nov 02 2008

Live File System - Allows you to add and erase files, like a USB
flash drive. Might not be readable on operating systems before
Windows XP.

la Mastered - Readable on all computers and some CD/DVD
players. Requires you to write all files at once, and individual
files can't be erased afterwards.

Which CD or DVD format should I choose?

A Hide formatting options Next Cancel

Click Next and a Computer window opens asking you to drag
the required files onto the CD/DVD drive (frequently drive E:), as
shown on the next page.
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File Edit View Took Help

Folders

Serif

Symantec
windows

Windows.old

Windows.old.000

The UTI Solution.zip

HP_RECOVERY (D:)

 DVD RW Drive (E)

Removable Disk (F.)

v Name
Excel spreadsheets

Drag files and folders
to copy to a CD, DVD
or flash drive
(Removable Disk (F:)
shown below left)

After you have dragged the required file or folder and dropped it
over the E: drive (or perhaps
D: or F:), a balloon appears
on the Taskbar at the bottom
of the screen, as shown on
the right.
When you click the balloon, the files or folders to be copied are
displayed at the top right of the Computer window as shown
below. Now click Burn to disc off the toolbar, as shown below.

0 You have files waiting to be burned to disc.
to see the files no*, cbciE thes bdoow

1'  Computer  DVD RW Drive (E:)

File Edit WC* Toots Help

Folders Ne Name Size Type

in Desktop
ID Jim

Public

Computer

Floppy Disk Drive (k)

Files Ready to Be Written to the Disc (1)

Excel spreadsheets
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The Burn to Disc dialogue box appears, with an option to add
your own Disc title instead of the current date used by default.

Burn to Disc

Prepare this disc

Q4SC

v 02 2008

ljecordvvg speed:

Ness files beep wntten to the disc will replace any files already on the disc if they have the
lame name.

Close the Nvizard after the Nes have been wntten

Next

IMP

Cancel

Click Next and the actual burning and copying process begins.
After a short time the following dialogue box appears, stating that
the burn was successful and giving you the chance to copy the
same files onto another disc. Click Finish at the bottom of the
dialogue box to eject the disc.

Burn to Disc

You have successfully written your files to the disc

Do you wait to aeate mode- disc Lisyl these same MeV

Yes, turn these flies to another disc

LIM
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Checking the Files on a Backup CD
Copying files and folders to CD (or DVD) has, in my experience,
always been extremely reliable. However, to check that your
backup is an exact copy (and that you have copied the right
files), place the disc back in the drive. The AutoPlay menu may
pop up, with an option to Open folder to view files. Or the
Computer window may open automatically, showing any folders
on the disc, such as Excel 2007 spreadsheets, shown below.

o Computer  DVD RW Drive (E:) Nov 02 2008

File Edit View Took Help

Folders

 El Desktop
g Jim

Public

a Computer

Name SIZE Type

Files Currently cn tie Disc 12t

Excel 2007 spreadsheets

Double-click a folder to check its contents, such as the Drink
Sales November.xlsx file shown below. Then double-click the
spreadsheet file to open it in Excel.

o Computer o DVD RW Drive (E:) Nov 02 2008

F do E dit view Took Help

Folders V Mane Size

Desktop Files Currently on the Disc (1)

Jim _11Ehirik Sates November- 10 KB

Public

To check the date a file or folder was modified, etc., select Views
form the Menu Bar above and then click Details.
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The USB Flash Drive or Memory Stick
These devices are an extremely fast and convenient form of
storage. They are a type of a dongle, a small device which plugs
into one of the USB ports on the computer. The USB ports are
usually two or four small rectangular slots on the back and
sometimes also on the front of the computer.

A flash drive appears in the Computer window as a
Removable Disk, usually designated (F:), (G:) or (H:), etc.,
depending on what other storage devices are fitted to your
machine, as shown below and on the next page.

))))
Removable Disk (F:)

The USB flash drive is very easy to plug in and remove and,
being roughly the size of a little finger, is extremely portable.
Being a USB device, the flash drive can be "hot -swapped", i.e.
plugged in and detected while the computer is up and running.

The USB flash drive can be used as a form of backup storage
and is available in a range of sizes from 256MB to 5GB with
prices starting from just a few pounds for the smaller versions.

Obviously if you need to build up a large permanent archive for
all of your spreadsheets or music or photographic files, for
example, a number of CD -Rs or DVDs is a safer solution.
However, the USB flash drive is ideal for anyone on the move,
wanting to move files quickly between laptop and desktop
computers or share files with friends or colleagues in a fast and
easy fashion. As mentioned earlier, I use flash drives, (also
known as "memory sticks"), to make quick daily backups. As the
flash drive can be written to many times, each day the latest files
overwrite the earlier versions. For complete safety, every week
permanent archive copies of the files are made to CD or DVD as
described in the previous section.
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Recovering Files from a Flash Drive or CD
Both USB flash drives and CD/DVD drives appear as additional
devices in the Computer window, shown below and accessed
from the Start menu.

Hard Disk Drives (2)

HP PAVILION (C:)

,-t r.o rp

Devices with Removable Storage (3)

)))) HP RECOVERY (D:)

eho _ .5 GB f ice of 5.9c: 2

DVD RW Drive (E:) Dec 03
Floppy Disk Drive (A:) -, Q 2008

tat imil

____0-) Removable Disk USB Flash Drive

If you need to recover the files you've backed up onto a flash drive, CD
or DVD, etc., place the removable medium it the computer. Start up the
program used to create the file, in this case. Excel 2007. Now click the
Open option off the Office Button menu. Select the required drive (E:,
F: or G:, etc.) and then click the folder, in this example Excel 2007
spreadsheets, from the drop -down menu under Folders shown below.

Open

" Excel 2007 spreadsheets

 Documents
Recent Places

Desktop

More >>

Folders

Removable Disk IV)

Excel 2007 spreadsheet,.

Name Date modified

jDnnk Sale; November.... 02111%2008 09:42
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Select the file Drink Sales November in the Open window
shown on the previous page and then click the Open button at
the bottom right of the window. The spreadsheet Drink Sales
November should now be displayed on the Excel 2007 screen
as shown below.

Drink sales Novernberidsx - Microsoft Excel

Home Insert Page Layout Formulas Data Review iew

Paste

Clipboard

D35

Calibri

B I U -
- II - A A -

Font

A - A 

I.

51-, General

W FE -A- %

Ile if v.-
Alignment Number

2

A B C D E

Drink Sales

Description Price Number Sold Sales

5 f. f
6 Tea 2.25 29 36.25

7 Coliee 1.29 35 45.15

8 Orange 0.90 19 17.1

9 Lemonade 0.85 11 9.35

Another way to open a file from a hard disc, CD or DVD (or any
other disc or medium such as a removable USB flash drive) is as
follows. Display the file name, e.g. Drink Sales November in the
Excel 2007 Spreadsheet folder shown previously, in the
Computer feature.

Name Dale meddled

'.1jDrink Sales November.... 02/11/2008 09:42

If you double-click a file name such as Drink Sales November
or its icon, as shown above, the file will be opened in the
program which created it, Excel 2007 in this case.
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The following pages discuss some "housekeeping" tasks to
ensure that your computer keeps running efficiently. If it develops
a hardware or software problem you may, in the worst case,
need to have your hard disc wiped and the software and data
files (such as spreadsheets) will need to be re-insta led, all being
well using easy -to -find backup copies, as described earlier. The
Windows XP and Vista operating systems provide several tools.
i.e. utility programs, to help maintain the efficiency of your
computer.

Disk Cleanup - Removing Redundant Files
During normal running, your computer creates a lot of temporary
files on the hard disc. When you browse the Internet. the content
of Web pages is saved so that the site can be viewed more
quickly at a later time. When using programs like Excel 2007, a
lot of temporary files are created. These take up disc space and
if ignored for a long time may cause the computer to run slowly.

To remove these redundant files cluttering up your hard disc. run
Disk Cleanup. once a week say, by selecting Start. All
Programs. Accessories. System Tools and Disk Cleanup.

System Took

 Backup Status and Configuratici

Character Map

la Computer

A Control Panel

Disk Cleanup

lit Disk Defragmenter

Recent Items

Computer

Network

After you've used Disk Cleanup once, in future the program can
be launched directly from the main Start menu. A window opens
giving you the chance to clean up just your own files or the files
of all users of the computer.
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After making a selection, you choose the drive you wish to clean
up - usually drive (C:). Disk Cleanup then takes a few minutes
to calculate how much disc space can be saved by deleting
unnecessary files.

After calculating the potential gain in recovered disc space, the
unnecessary files are listed, as shown below.

Disk Cleanup for HP_PAVILION (C:)

Disk Cleanup L

You can use Disk Cleanup to free up to 2 E l GB of disk
space on HP_PAVILION

Files to delete:

F1..] Downloaded Program Files 2.04 MB

i 4, Temporary Internet Files

..t. Offline Webpages

LE

L E Hibernation File Cleaner

1-j, Debug Dump Files
'VW

36 2 MB E

1?7 KB

1 24 GB

1%. MB

Total amount of disk space you gain

Descnption

Downloaded Program Files are ActiveX controls and Java applets
downloaded automatically from the Internet when you view certain
pages They are temporanly stored in the Downloaded Program
Files folder on your hard disk

How does Disk Cleanup work 1

L

17 MB

View Fies

Cancel
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When you click on an entry, such as Temporary Internet Files,
the purpose of the files is explained in the Description panel as
well as guidance on the effects of removing them.

Decide which files to delete and mark their check boxes with a
tick. The amount of free disc space to be gained is displayed in
the window shown on the previous page. When you've marked
which files are to be deleted, click OK and the window shown
below appears.

Disk Cleanup ar

Are you sure you want to permanently delete
these files?

Delete Files Cancel

Click the Delete Files button shown above to complete the
cleanup operation.

You can quickly check the free space on your hard disc by click-
ing the Start orb, then click Computer off the Start menu. The
extract from the Computer window below shows that the hard
disc drive (C:) initially had 24.0GB free space. After running Disk
Cleanup, the amount of free space increased to 24.2GB.

HP_PAVIUON (C) HP_PAVIUON (C:)
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Using Disk Defragmenter
After you've been using your computer for a while, many files will
have been repeatedly modified and resaved. The original files
and the changes may become separated, scattered about the
hard disc in different places. This will impair the performance of
the computer when it tries to open a file which is spread around
many different locations; defragmentation is a process which
rearranges the hard disc to make it run more efficiently. In

Windows Vista, the Disk Defragmenter program is scheduled to
run automatically. Alternatively it can be launched by clicking the
Start orb then selecting All Programs, Accessories, System
Tools and Disk Defragmenter.

After you've used Disk Defragmenter the first time, the program
can be launched in future by clicking its name, which by now will
be listed on the Start menu.

. System Tools

Backup Status and Configuratioi

'./ Character Map

.111 Computer

Control Panel

7, Disk Cleanup

Disk Defragmenter

6 Internet Explorer (No Add-ons)

Recent Items

Computer

Network

Conned To

The Disk Defragmenter window opens, as shown on the next
page. In this particular example, the Disk Defragmenter
program has been scheduled to run once a week, but you can
change this if you wish after clicking Modify schedule....
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roskill1111111111.ocirnevrterot _gt_ 

Drsk Delragrneulet cornolfdales raymeried files on your compuler ; hard d. -t to rmproye system
performance. Hon does DO' Drtiymcntef help'

Ron on a schedule frecornrnentkv11

Run al 01 09 every Wednesdas ,tortery 01 /01 /2005

led fun. 16/01 /20081915

Nevi hootolet1 tun: 23/01 i2008 01 OD

Scheduled def enabled
/ 3.. di to Ott rorr, ord. ion -o

LMocily -

[Mummer.. now

-

PleasePlease also note in the Disk Defragmenter window above, the
Defragment now button allows you to manually start an

immediate defragmentation whenever you think it might be
beneficial. Select the drive you wish to defragment, usually (C:)
then click the Defragment button.

The defragmentation process may take several minutes or a few
hours, depending on the size and state of the hard disc.
Fortunately you can continue to use the computer while the Disk
Defragmenter program is running.

Good Housekeeping

It's recommended that, in order to keep your computer running
efficiently, Disk Cleanup and Disk Defragmenter are run
regularly - at least once a week, especially if the computer is
heavily used. If the computer appears to be running slowly for no
obvious reason, it may be worth carrying out a manual
defragmentation.
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System Restore
This feature takes a "snapshot" of the critical settings in Windows
and other software on your computer. It does not make copies of
your data files such as Excel spreadsheets, so you should still
make backup copies as described earlier. System Restore
saves a collection of critical settings known as a restore point.
Restore points are scheduled to be saved automatically or you
can make one at any time manually by clicking the Create button
in System Protection within System Restore.

If something goes wrong with your machine, perhaps after install-
ing new software or hardware, you can revert to a restore point
made at a time when you know the computer was working well.
The computer will then have the same settings as it had at the
time of the chosen restore point.

System Restore

Choose a restore point
System Restore will not change or delete any of your documents reversible. 1111

call nitre port kit you want to use and limn Mt Net. How do I choose a restore point?

arrant line acne: GMT Standard Tine

rDate and Tme Descripbon

30/10/2008 08:37:22

27/10/2008 09:05:19

26/10/2008 14:41:25

25/10/200809:20:19
16/10/2008 08:36:44

12/10/2008 10:08:24

Instal: Windows Update

System: Scheduled Checkpont

System: Scheduled Chedipont

Instal: WrIdows Update

Instal: Wndows Update

Instal: Dews Driver Package Instal: Symantec Network Service

sow reshwe posits older than 5 days

< Sack Cancel
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Windows Update
This feature, launched from Start and All Programs, enables
you to download from the Internet the latest modifications to the
Windows software and install them on your computer. Such
modifications, often called "patches", might, for example, be
intended to close a breach in the security of the Windows
operating system. This could potentially allow "hackers" to gain
access to your computer and possibly steal financial or personal
information.

u Windows Movie Maker

1=1 Windows Photo Gallery

Windows Update

Accessories

ArcSoft PhotoImpression

Belkin

Brother

Canon LASER SHOT LBP-1120

Corel Paint Shop Pro Photo X2

EPSON Scan to Web

Back

'Start Search

>>

Network

Conned To

Control Panel

Default Programs

Help and Support

'-'7501019111""7-

You can schedule your computer to check for updates at a
certain time every day. Updates are dow'iloaded from a Microsoft
Web site; you are tole which updates are available and can
choose whether to download and install individual updates to
your machine. When version 11 of the Windows Media Player
was launched. it was available for downloading as an automatic
update for users of Widows XP. (The Windows Media Player
version 11 is provided as standard in Windows Vista).
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Summary: Safety Precautions
Always make backup copies of important spreadsheet
files. Use a removable storage medium such as CD,
DVD or flash drive (memory stick).

Label the backup copies and store them safely.

Check that the backed up files can be retrieved and
opened in Excel 2007.

Use the Windows System Tools, Disk Cleanup, Disk
Defragmenter, to remove redundant files and optimize
storage on your disc.

Use System Restore to overcome software problems;
the computer is returned to an earlier configuration,
saved at a time when the computer was working
correctly.

Make sure Windows Update is switched on so that the
latest Windows software modifications are downloaded
to your computer from the Internet.

Obtain a plug-in surge protector, costing 0-£10, to
prevent surges or spikes in the electricity supply from
damaging your computer and its hard disc. Some
extension leads have built-in surge protectors.

Any cut in your electricity supply or surge in power can
cause loss of data and possible damage to equipment.
An Uninterruptable Power Supply (UPS) provides
instant battery power so that data can be backed up or
the mains power restored. A UPS may also give
protection from power surges. UPS devices for home
or small business cost 00-£110.

Always finish a session using Shut Down on the right
of the Start menu. Simply switching off the computer or
the power point can damage files which are open.
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External Threats to
Your Excel Files

Introduction
This chapter continues with the task, started in the last chapter,
of safeguarding your Excel files; the following pages concentrate
on threats to your files from the outside world. Even though your
computer is apparently sitting safely in your home or office, there
are plenty of threats to your files from outside - largely due to
the Internet and wireless broadband, as outlined below.

A "hacker" might gain access to your computer and
copy important files such as Excel spreadsheets.

A virus might attack your computer and destroy files or
even wipe the entire hard disc.

You may be using an unsecure wireless router for
your Internet connection. Other people nearby can
detect your network, use your Internet connection and
intercept information being sent and received.

Your Excel files may be stored on a laptop computer,
a flash drive, "memory stick" or a removable hard
drive; these may be lost or stolen.

The computer might be damaged in a fire or flood.

Windows Vista and XP have several built-in software features to
protect your files from external threats and there are numerous
other products from third party suppliers. These are discussed in
the remainder of this chapter.
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The Windows Security Center
You can carry out an audit of all the security
features in Windows by launching the Windows
Security Center. Click Start. Control Panel and
double-click the Security Center icon as shown on
the right. You are recommended to make sure that
the main security features are either switched On or
marked OK as shown below.

wit

Security
Center

r Windows Security Center

Security essentials
To help patent your computes make sure the four secunty essentials beton are marked On or

g Windows Security C enter

Firewall

Norton Security Online reports that it is currently turned on
Shoe. me the 1,e,e1 pr,gen, , :

On A

Note Two or more firroalls running at the same time can conflict with each other.
Now does a fee...0 help protect my compute/7

Iratomatic updating On 
As updates become available Windows installs them for you (recommended) Automates/ay
installing updates can enhance the serum) and performance of your computer

Now does automatic updat'ng help protect in. computer'

pare protection On "
Wes protection

Norton Security Online reports that it is up to date and )irus scanning ie eas.

Spyware and other inalware protection

Norton Security Online reports that it n turned on
Shco me the antisp,oare programs on this cprhp.a.

Non does enti.rriskosre softoare rico protect my Cernp,..e.

spew security settings OK 111

On e

cm.

In the Windows Security Center shown above, each of the
main features, Firewall, Automatic updating and Malware
protection, etc., has been expanded to
give more information. This is done by
clicking the downward pointing arrowhead,
as shown here on the right. In the Security Center as shown
above, click the upward pointing arrowhead to collapse each
security feature.

Orl
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The Windows Firewall
The firewall is a piece of software or hardware designed to
protect your computer f-om criminal activity such as hackers or
fraudsters. Windows has its own firewall which should be turned
on, unless you have installed an Internet security package which
includes a firewall, such as Norton, F -Secure or McAfee.

Turning Windows Firewall On

Select Start. Control Panel, then double-click Windows
Firewall and click Change settings. If necessary click the
circular radio button to make sure Windows Firewall is On.

7

Windows Firewall Setting:

General Excepbons I Advanced

L1 Wnclohs Frewril as helpng to protect your cam:siker

VindoAs Firewall can help prevent hackers or malicious softy:are from gaining
access to your computer through the Internet or a network.

l*  so (recommended}

This setting blocks all outside sources fro., connecting to this
computer, except for those unblocked or the Exceptions tab.

Mock all incoming connections

Select this opon ...sen you connect to less secure networks. Al
exceptions be ignored and you n# not be notified when

indows Firewall blocks programs.

Off (not recommended)

Amid using this setting. Turning off 'iVincoys Firey:all will make this
computer more vulnerable to hackers or malicious software.

Tell me more about these settngs

r o 1 Cancel
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Automatic Updating
Windows Update provides regular modifications to the Windows
operating system; these are often designed to make the system
more secure and take the form of a small piece of software or
"patch". Windows Update allows you to schedule your computer
to check for the latest updates and download them to your
computer from the Internet. Sometimes completely new versions
of a major Windows component such as the Windows Media
Player may be available as an update.

Windows Update can be launched initially from the Start menu,
then All Programs and Windows Update. The next time you
want to use Windows Update it can be launched directly from
the main Start menu. As shown below, the Windows Update
screen opens and displays the update status of your computer.

r Control Panel r Windows Update

Jew Took

 Check for updates

Change SettongS

View update history

Restore hidden updates

Updates: frequently asked
questions

Windows Update

Windows is up to date

is,..ailahle I optional update:

No rte., important update: xe available for your computer.

Most recent check for update: Today at 1946

Updates were installed 10/0l /MS at 10.27. View update hr,tcr.
You have Windows set to: Autonsatically irratall new updates every dr .0 0;,1)

lrecornrnettled)

As shown above, you are informed when Windows Update last
checked for available updates and the date when updates were
actually installed. Clicking Check for updates above on the left-
hand side allows you to carry out an immediate, unscheduled
check for available updates.

Change settings, shown on the left of the image above enables
you to schedule automatic daily or weekly checks for updates.
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o Install updates automatically (recommended)

Install new updates

Every day at 03:00

Download updates hut Id me choose whether to install them

Check for updates but Id ME ( home v,:beiher to download and install Own

The radio buttons (circles) above allow you to choose whether
you want automatic installation of updates or to control the
downloading and installation yourself.

Clicking View update history shown on the left of the image on
the previous page shows the updates that have been installed on
one particular computer. The list can be scrolled to view almost
an entire year of updates.

w _ Panel  Mn Pc", Jperte Yoe. update ',Mori .t
W. 1de Wruo juilt yey

Rev,ew your update history

Mohr r lung Wm n.t to welt. wri Inratisiim mmuMui uuMrs es..1," Maid winos r.
1 rcubie.brrr pectienis r

Mom (Moe 14.
Umber. Mr Mlwoews Mad he& Emil Fan Pawls, 411119.Mbb

MEM, Updar ler M.OsenV
Sus (mid mommlell minor*
Se. (mid Immarei 1001111/2WIS1e PPM.

Modes Olrhms Salm Ilememl led 1.nuary SIt twalul Immo. 111411./201.6- (101W130)

*Mr._ MEM.. 1110101331171

for Mo..
Mcm:Jul )114111i7WISummulwl
SwrrJJ 111/111/20MDarr 111111WWW1

11Maik Mr MMus WM 113043411 I
SIR lIpMe I Womb. Y.1. 11101154.111

trs,Jul Munn.. 111411210.

Sow trithil 1347/700/Vey

Sul (100, WIP/ISMI Impumn. 13/11/1017t.er
( Smalls llpOre Mr I/1MM 1.p4ow 7 Modems V.1. Sq. cc:Jul 13/12/211117mmisMe Wi 11101.26

4cr.ev Upplah le *SWAY% Yet. 010762/1
WmIlms MM. Rewmal led.

Ms vsful ivuorn
L. Impnw 1312/2107um SeOwrr Memos, 711 0110111301

lIMM Iw NWT i001 Mod UM I  .....11dIn tOtr emiar 104a11101116066)

Sns.v lkrdrs loo Mullins YY. WW1

Soet toselid wommird 1341/78117

truhd Immme. 13/11/10W01P1

1te MuMws wd. Ma I maul 13111/711117WWW7W31

( muMm 1Ipd lor MM. ( .'..Inns Vera 0>KYI IA) Mc I mild smurrhrrl 2041/1011

00. ler Moscow, Yee. WW.1)69I Mt( ezehl Rat tow..Mod 1641/717
Moms WM um 4.1 aw.nr 1.d Ilmwdurs1007 00110611301 Sax( rs.M.1 Impumu 164.11/71/
thr.d. Viss 0.&016801 Sus msllul 161//717teumemMI

ca
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Malware Protection
Malware is an abbreviation for malicious software and refers to
computer viruses and other malevolent programs; the computer
virus is a small program written for the purpose of causing
damage and inconvenience. In the worst case it might cause the
contents of a hard disc to be wiped.

Malware protect on On 4.) A

Virus protection On v
Norton AntiVirus reports that d is up to date and virus scanning is on.

Spyware and other malware protection On ro

Norton AntiVirus reports that it is turned on.
Shoo, me the antuspyware programs on thus computer.

He., :Ice' ant mil..Ire cft.,,are help protect my computer'

The Malware protection extract from the Windows Security
Center shown above reports on any anti -virus software installed
on your computer. It's essential that you have an anti -virus
program installed and that this is regularly updated so that it can
detect and render harmless the latest viruses.

Well known anti -virus software includes Norton AntiVirus,
McAfee VirusScan, F -Secure Anti -Virus and AVG Anti -Virus.
Many companies also produce complete Internet security
packages which include anti -virus software as well as firewalls
and protection against spyware - software designed to collect
personal information from a computer.

Anti-virus/Internet Security packages typically cost £20 - £40 and
this includes the software CD or DVD and a year's updates of
virus definitions. Updates are normally downloaded automatically
from the Internet. Many companies now allow one software
package to be legally installed on up to three computers.
Subscriptions to an anti -virus package are normally renewed
annually.
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Norton 360
Norton 360 provides total protection for your files in a single
package. This includes anti -virus software as well as protection
from hackers and "spyware-. Spyware is illegal software installed
on your computer via the Internet. This can monitor your Web
surfing. alter settings and take control of some aspects of your
computer. Norton 360 can be bought for under £60 and may be
installed on up to 3 computers running Windows Vista or XP.

61 Norton 360

Norton 360 PC Security - Details
Kelp& Support

CO PC Security - Details Protected

Items

Cia Auto -Protect

Your PC is automatically protected from viruses spyware and
other risks

Furewall

Your PC is protected from intrus ons and hacker attacks

LiveUpdate
Your use 8 threat protection has been updated recently

Virus and Spyware Scan
Your PC is protected from viruses spiware and other nsks

O Email Scanning
Your incoming email attachments are protected from viruses
spyware and other threats

Q Windows Update
Your PC is set to receive the latest Windows updates
automaticall,

00 Intrusion Prevention
Your PC is protected from intrusion attempts

Things You Can Do

Run Scans Cfle-

Status

Last no, 03:11.2008

Last run 02 '' I. 2008
More Into

On

On

As shown above, Norton 360 protects files from viruses and
there is a Firewall to keep out hackers. As new viruses are
discovered, the Norton 360 database of known viruses is

automatically updated on your computer via the Internet.
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AVG Anti -Virus
This software, available for Windows Vista and Windows XP, can
be obtained as a free 30 -day trial download from the AVG web
site at www.avg.co.uk. As can be seen below, it includes a
Firewall. Anti-Spyware and Anti -Virus protection with
automatic updates to enable it to recognise the latest viruses.
There is also Anti -Spam protection to filter out unwanted and
fraudulent e -mails.

g. AVG Anti -Virus Fres

diAVG
Anti -Virus ..LJ

FItt Ediusa

Ovenna.

N, Computes scan..

Update now

Steadies

Led wen Not yet scanned

Lost update 03/11/133. 11 V

Vous DB 270.8 5/176.1

AVG rayon 8 0 100

Larne awes Flee

You are protected

Al security features are working correctly arid are up to date.

Security components and status overview

Ara Vous Antt.Spayme mad Scanner

hcense lakScannet Raeder Shaer

I

-- Update Manage,

Descopttun of selected compared

Selected component clescrpton (no component selected oght now).

You can upgrade from the trial version of AVG Anti -Virus to the
full version for £39.99, at the time of writing.

Anti -virus programs normally carry out automatic scans at regular
times which you can schedule: it's also possible to launch a
manual scan whenever the need arises.
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Wireless Network Security
Wireless broadband routers have greatly improved most people's
Internet experience bit, without adequate precautions, your
network of one or more computers may be insecure. This is
because anyone, such as a near neighbour with a wireless -
enabled computer or someone in the street with a wireless
laptop. may be able to cetect your network and use your Internet
connection. As shown below, my computer has detected my
BTHomeHub plus two networks belonging to neighbours. One of
these is about 30 metres away and is listed as an Unsecured
network in the Connect to a network feature in the Windows
Network and Sharing Center, as shown below.

: A .1 tier 10::Are, K

'he:, All r

` BTI-lomel-lub -5778 Connected

a; whdebax 3eturrty 'enabled network
rre

walkers network Umecured networkt
Cruet

Although a firewall should stop anyone getting access to your
computer and its files, it's possible for a determined hacker to
intercept your network 'traffic", including for example, Excel 2007
files which you have e -mailed.

Making a home or small business network secure usually
involves setting up a wireless key, or password. Also data files
(such as Excel spreacsheets) are encrypted i.e. scrambled to
make them incomprehensible to any hackers eavesdropping
within the range of your wireless network signals.
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Summary: External Threats to Your Files
Use the Security Center in Windows Vista and XP to
turn on the Windows Firewall to prevent hackers from
getting access to your files. Alternative y install a

firewall from a 3rd party company as part of a complete
Internet security and anti -virus package.

 Make sure that Automatic Updates is turned on in the
Windows Security Center. so that you automatically
receive the latest modifications intended to improve
Windows security.

Install anti -virus software which is regularly updated to
detect and eradicate the latest viruses.

If you are using a wireless broadband rcuter, make
sure it is a secure network which uses encryption
and requires wireless security key to gain access.
Otherwise people nearby can eavesdrop, share your
Internet connection and intercept your data.

 The Web site for the manufacturer of your router should
explain how to make your network secure.

If possible, try to locate your computer and backup
media in secure situations where there is minimal risk
of theft, floods or fire. Install a smoke alarm in rooms
where computers or backup media are kept.

 When travelling with a laptop computer or with
removable media such as CDs, memory sticks or
removable hard drives, take care to ensure that
important files are not lost or stolen.
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Glossary of Spreadsheet Terms

Alignment The position of text or data in a cell - left, right or
centred and top, bottom or middle.

AutoSum An icoi giving access to various mathematical
functions, such as total and average.

Backup A duplicate copy of a file, to be used if the original
is lost or damaged.

Cell Small box on a spreadsheet which can contain a
number, label or formula.

Cell reference The column and row headings which locate a cell
on a spreadsheet table or grid, e.g. D9.

Chart A diagram allowing sets of numerical data to be
compared, e.g. pie chart and column chart.

Clipboard An area of memory used to hold data temporarily
during copying and "cut and paste" operations.

Computer A window used to display and manage the discs,
folders and files on a Windows Vista computer.

Drag and drop Holding down the left -mouse button to move a
screen object then releasing at the new position.

Excel 2007 The World's leading spreadsheet program.

File A spreadsheet or other document saved on a
magnetic medium such as a hard disc.

File type The format used to save a document such as a
spreadsheet, e.g. *.xlsx for an Excel workbook.

Folder The electronic equivalent of a wallet file.

Font (Fount) A style and size of letters, e.g. Arial 10 italics.

Format Painter A "brush" tool for copying the style and layout of
text or numbers from one cell onto another cell.

Format The style, colour and alignment of text plus

currency signs and decimal places in numbers.
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Formula Bar

Function

Gridlines

A rectangle at the top of a spreadsheet, allowing
the entry and editing of formulas in a cell.

A formula which can be selected from the Ribbon,
such as Total or Average.

Vertical and horizontal lines on a spreadsheet.

Label Text used as a heading for a set of data.

Office Button Spherical icon at the top left of the screen, which
launches the main menu for saving, printing, etc.

Office 2007 Suite of Microsoft software including Excel 2007
and Word 2007 and various other programs.

Quick Access Small row of icons at the top left of the Excel
Toolbar screen, for tasks such as Save, Undo, New.

Recalculation If a number in a cell is changed, any dependant
calculated cells are corrected automatically.

Replication down a column or along a row,
automatically amending the cell references.

Ribbon A rectangular bar across the top of the Excel 2007

screen containing numerous tool icons.

Right -click Clicking the right-hand mouse button to produce
menus relevant to the current cursor position.

Save Storing a spreadsheet on a hard disc, etc.

Spreadsheet A grid of cells or small boxes containing numbers,
labels or formulas, enabling rapid calculations and
easy drawing of charts.

Windows Operating system for a PC computer, providing the
"user interface" of windows, icons and menus. XP
and Vista are the latest versions.

Worksheet Another name for an Excel spreadsheet.

Workbook A set of several Excel worksheets saved and
displayed as a single file. Worksheets are

accessed by tabs at the bottom of the screen.
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BP 701

A Babani Computer Guidebook Suitable for All Ages

An Introduction to Excel Spreadsheets
The practical and friendly approach of this book will help
newcomers to easily learn and understand the basics of
spreadsheets. This book is based on Microsoft's Excel 2007
spreadsheet, but much of the book will still apply to earlier
versions of Excel. The book is written in plain English. avoiding

technical and mathematical jargon and all illustrations are in full

colour. It is suitable for all age groups from youngsters to the
older generation.

Among the many topics explained are how to:

Install the software

 Use the exciting new features of Excel 2007
Create and use a spreadsheet

Enter, edit and format text. numbers and formulae

 Insert and delete columns and rows
 Save and print a spreadsheet
 Present the information on a spreadsheet as a graph or chart
 Manage and safeguard Excel files on disc
 Use Excel as a simple database for names and addresses.

This book will help you to quickly gain confidence and get to
grips with using spreadsheets. In fact you will wonder how you
ever managed without them.
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